
Doc 1.5, Ver. 1.0| May, 2012

ALMA Observing Tool User Manual

Rein H. Warmels

ALMA, an international astronomy facility, is a partnership of Europe, North America and East Asia
in cooperation with the Republic of Chile.



For further information or to comment on this document, please contact your regional Helpdesk through the ALMA User
Portal at www.almascience.org. Helpdesk tickets will be directed to the appropriate ALMA Regional Centre at ESO,
NAOJ or NRAO.

Version Date Editors

0.5, Ver. 1.0 March 2011 Rein Warmels
0.5, Ver. 1.1 August 2011 Rein Warmels
1.5, Ver. 1.0 May 2012 Rein Warmels

The ALMA OT Team, and the many Testers.

In publications, please refer to this document as:
OT User Manual 1.5, Version 1.0



Contents

1 Introduction 5
1.1 Purpose . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5
1.2 Release Information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5
1.3 Documentation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5
1.4 User Support . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6
1.5 Credits and Acknowledgements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6

2 Install and Run the Observing Tool 7
2.1 Hardware and Software Prerequisites . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7

2.1.1 Supported Platforms . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7
2.1.2 Java Software . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7
2.1.3 Disk Space Required . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8

2.2 The Java Web Start Installation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8
2.2.1 Verifying Java Web Start . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8
2.2.2 Starting the OT . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8
2.2.3 Running the OT offline . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9

2.3 Tarball Installation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10
2.3.1 Installation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10
2.3.2 Starting the OT . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10

3 Basic Concepts 11
3.1 Phase-1 Proposals . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11
3.2 Phase-2 Programs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11
3.3 Science Goals . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11
3.4 Scheduling Blocks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12
3.5 Observing Unit Sets . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12
3.6 Project Submission . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12
3.7 Project Validation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12
3.8 AOT files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13
3.9 Project Conversion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13

4 Overview of the Observing Tool 15
4.1 Help . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15
4.2 The OT Main Graphical Interface . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15

4.2.1 GUI Parameter Fields . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15
4.2.2 GUI Features . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16
4.2.3 Menu and Toolbar . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17
4.2.4 The OT Panes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17

4.2.4.1 The Project Structure Pane . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17
4.2.4.2 The Editors Pane . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18
4.2.4.3 The Feedback Pane . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18
4.2.4.4 The Overview Pane . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19

4.3 OT Configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19

1



5 Tools and Simulators 21
5.1 The ALMA Template Library . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21
5.2 Sensitivity Calculator . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22
5.3 Spectral Line Selection Tool . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22
5.4 Calibrator Selection Tool . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24
5.5 LO Configuration Tool . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25
5.6 Calibration Time Estimate Tool . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25

6 The Phase-1 Observing Proposal 27
6.1 Open a Phase-1 Proposal . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27
6.2 The Proposal Form . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28

6.2.1 Adding Investigators . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28
6.2.2 Scientific and Technical Case . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29

6.3 Adding Phase-1 Science Goals . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30
6.3.1 General . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30
6.3.2 Field Setup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30

6.3.2.1 Source properties . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30
6.3.2.2 Resolving source information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31
6.3.2.3 Field definitions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31

6.3.3 Spectral Setup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32
6.3.3.1 An introduction to the ALMA backend . . . . . . . . . . . . . . . . . . . . . . . 33
6.3.3.2 Spectral Line . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33
6.3.3.3 Single Continuum . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35
6.3.3.4 Multiple velocities and tuning solutions . . . . . . . . . . . . . . . . . . . . . . . 35

6.3.4 Calibration Setup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35
6.3.5 Control and Performance . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36

6.3.5.1 Imaging considerations and the ACA . . . . . . . . . . . . . . . . . . . . . . . . 36
6.3.5.2 Sensitivity considerations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37
6.3.5.3 Time Estimation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37
6.3.5.4 Additional time issues . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38

6.4 Summary Information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39
6.5 Proposal Validation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39
6.6 Proposal Submission . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39

7 Phase 2 Science Goals 41
7.1 Basic Information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41

7.1.1 Loading Project Information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41
7.2 Create Science Goals . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42

7.2.1 Science Goal Visual Editors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42
7.3 Generate Scheduling Blocks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42

7.3.1 Scheduling Block Restrictions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43
7.3.2 Algorithm Used for Splitting SBs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43

7.4 Phase 2 Validation and Submission . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 44

8 Phase 2 Scheduling Blocks 45
8.1 Starting Up . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45
8.2 Phase 2 Observing Programme Structure . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45

8.2.1 The Observing Unit Set . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45
8.2.2 The Scheduling Block . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47
8.2.3 Targets and Resources . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 48

8.2.3.1 Targets . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49
8.2.3.2 Resources: Field Sources . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50
8.2.3.3 Resources: Instrument Setup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50
8.2.3.4 Resources: Observing Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . 50

8.3 Targets . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50
8.3.1 Add a Science Target . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51

2



8.3.2 Add a Calibration Target . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52
8.3.3 Observing Groups . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52

8.4 Resources . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53
8.4.1 Field Sources . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 54
8.4.2 About Basebands, SideBands and Spectral Windows . . . . . . . . . . . . . . . . . . . . . 55

8.4.2.1 Upper and Lower Sideband and Basebands . . . . . . . . . . . . . . . . . . . . . 55
8.4.2.2 Spectral Windows . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55

8.4.3 Instrument Setup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56
8.4.3.1 Three choices for the Instrument Setup . . . . . . . . . . . . . . . . . . . . . . . 56
8.4.3.2 Spectral Specifications . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56
8.4.3.3 Switching . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57
8.4.3.4 Square Law Setup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57
8.4.3.5 Correlator Configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57
8.4.3.6 BaseBand Configurations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58
8.4.3.7 Baseband Specifications . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58
8.4.3.8 Spectral Windows . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 59

8.4.4 Observing Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 61
8.5 Attaching Resources to Targets . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 62

8.5.1 Attaching New or Existing Resources . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 62
8.6 Submit the Project . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 63

9 The Visual Spatial Editor 65
9.1 Overview of the Graphical Interface . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 65
9.2 Creating a Field Definition . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 66

9.2.1 Single Pointings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67
9.2.2 Rectangular Areas . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67

9.2.2.1 Science Goal . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67
9.2.2.2 Scheduling Block . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68

9.2.3 Offset Versus Absolute Coordinates . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68

10 The Visual Spectral Editor 69
10.1 Overview of the Graphical Interface . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69
10.2 Viewing a Spectral Setup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 70

10.2.1 Science Goal . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 70
10.2.2 Scheduling Block . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71

A Project Conversion Tool - Command Line Version 73

B Create an External Ephemeris 75
B.1 NASA resources for HORIZONS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 75
B.2 Instructions and Setting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 75

C Observatory Setups 77
C.1 Holography . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 77

C.1.1 Astro-Holography . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 77
C.2 Optical Pointing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 77
C.3 Radiometric Pointing, Baseline Calibration, and Calibrator Survey . . . . . . . . . . . . . . . . . 78

C.3.1 Target List Editor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 78
C.3.2 Calibration Editor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 79

D Expert Parameters 81
D.1 Advanced Parameters in Observing Parameters and Scheduling Blocks . . . . . . . . . . . . . . . 81

E Acronym List 83

3



This page was intentionally left almost blank

4



Chapter 1

Introduction

1.1 Purpose

This manual describes the ALMA Observing Tool (OT) that is used to prepare observing proposals (Phase 1) and
to schedule approved observations (Phase 2) for the Atacama Large Millimeter/submillimeter Array (ALMA).
The OT is a Java-based application consisting of a set of user interfaces that are needed to prepare an ALMA
observing project. This consists of a valid observing proposal and/or an observing program containing one or
more Scheduling Blocks that are executed at the telescope.

Users who are completely unfamiliar with the OT are recommended to read the following chapters: Chapter 2
provides information about how to install, configure and run the Observing Tool, Chapter 3 describes the main
components of an observing proposal and program, and Chapter 4 provides a general overview of the OT.

In order to create a Phase-1 proposal, all the essential information is covered in Chapter 6 – this describes
the process in some detail and should be read by all users. Complimentary to this is Chapter 5 which describes
various OT tools and Chapters 9 and 10 that give detailed information on how to use the visual spatial and
spectral editors.

Phase-2 programs are covered in Chapters 7 and 8 although the chapters that cover the tools and visual
editors will also be of use here. These chapters are of limited use to normal users of ALMA and are of most
interest to expert users and observatory staff. The same applies to the Appendices that also cover special topics.

This manual is not a technical manual. Hence, detailed technical information about the ALMA hardware
systems will not be presented. However, the manual covers some technical aspects of, and references to, the ALMA
hardware that enables users to set up more complicated observing programs and non-standard configurations.
A detailed technical introduction to ALMA is given in the ALMA Technical Handbook (available at the Science
Portal).

1.2 Release Information

The current version of the manual is intended to be consistent with the OT Release for the ALMA Cycle-1 Call
for Proposals, 31 May 2012. Registered users can download this version from the ALMA Science Portal:

http://www.almascience.org

1.3 Documentation

The OT User Manual is intended for all ALMA users, regardless of their level of experience and provides
comprehensive information on how to create valid Phase-1 proposals and Phase-2 programs. However, giving
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full information about all fields and menus would make this hard to read. Therefore, an ALMA OT Reference
Manual is also available which contains comprehensive descriptions of all fields and parameters.

In addition a 10-step “quickstart” guide is available that demonstrates how to create an ALMA Phase-1
proposal and also forms the basis of a set of video tutorials. All of these can be downloaded from the Science
Portal and the User and Reference Manuals are also available through the OT.

1.4 User Support

In each of the three partner regions, an ALMA Regional Centre (ARC) has been established. Each ARC provides
scientific user support in the core areas of proposal preparation (Phase 1), observation program preparation
(Phase 2) and data analysis to users in their respective communities. The ARCs will also host copies of the
ALMA Archive and will deliver data packages to users. Hence, the ARCs are the ALMA interfaces to the user.

More detailed information about the ARCs and how the interaction with the user communities is organised
can be obtained from their Web sites. The following three URLs point to the European, North American, and
East Asian ARC sites:

Europe: http://www.eso.org/sci/facilities/alma/arc/
North America: https://science.nrao.edu/facilities/alma

East Asia: http://alma.mtk.nao.ac.jp/e/

Before and after the observations you will have regular interaction with your ARC. The degree of interaction
will vary and depend on your experience and the complexity of the project undertaken. For simple projects,
experienced users may only need to submit their Phase-11 and Phase-2 programs without any need for further
support and they will receive their data package from the ARCs. Inexperienced users and more complex programs
may require active ARC support during all phases of the observing program.

The Cycle-1 release of the ALMA Observing Tool is the official release of the OT for supporting the submission
of ALMA Cycle-1 Science proposals. In the event you encounter a problem or need support when using the ALMA
Observing Tool you can contact the ALMA User Support Service at your ALMA Regional Centre (ARC) or use
the ALMA Helpdesk. All of these can be reached via the ALMA Science Portal:

http://www.almascience.org

1.5 Credits and Acknowledgements

The ALMA OT is a software product of the ALMA Observation Preparation Software Team and is developed
on the basis of the ALMA Science Software Requirements (SSR) and the ALMA High Level Analysis (HLA)
documents, produced by the respective groups. The OT software group acknowledges the valuable inputs of
these groups during the development phases of the OT. Testers from the external community are also thanked
for their valiant efforts over the years.
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Chapter 2

Install and Run the Observing Tool

To prepare a Phase 1 proposal, or to specify an observing program during the Phase 2 process, you must use
the OT. The ALMA OT is available in two flavours: Java Web Start and tarball. The Web Start method
is recommended as it is much simpler. Provided a network connection is available, it will ensure that you are
running the latest available version of the OT. The tarball method is a more classical installation by downloading
and unpacking a tarfile containing the OT application and other files required to run the OT.

In this chapter, both installation procedures will be discussed. Before dealing with these two installation
methods, topics that are independent of the installation method will be presented first. These include supported
platforms, disk space requirements and the availability of Java.

If problems are encountered during installation and/or operation of the OT, users are recommended to
examine the Science Portal, especially the OT Troubleshooting and Known Issues pages, for solutions. The
Helpdesk may also contain useful information via its Knowledgebase system. If a solution to a problem cannot
be found, a user should then file a Helpdesk ticket.

2.1 Hardware and Software Prerequisites

2.1.1 Supported Platforms

It is expected that the OT will run on basically any machine that has an appropriate version of Java installed.
Regular testing of the OT has found that it works using all common Linux distributions, Mac OS X and Windows.
When reporting bugs, the platform that the OT is running on should be included.

2.1.2 Java Software

The OT is a Java application that will work on any compatible Java Virtual Machine (JVM) installed on your
platform. The JVM, if correctly installed, executes the OT platform-independent binary code. The JVM is
part of the so-called Java Runtime Environment (JRE), which is the software environment in which programs
compiled for a JVM implementation can run.

Because of its Java dependency, installing and running the ALMA OT requires the Java Runtime Environ-
ment, JRE 6.0 (which contains JVM 1.6). Most likely, Java is already installed on your computer. The version
of your Java installation can be checked from the UNIX and DOS Command Line using the command java
-version. The command will print a string like java version 1.6.0_05. If the Java version is earlier than
version 1.6, you should get the latest version of JRE from the Java download page:

http://java.com

This page contains downloads for the various platforms and instructions for the OT installation and deploy-
ment. One can also download the JRE software using the “Free Java Download” link that actually detects the
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platform in use. If you run into problems with the installation you can ask your computing support to install it
for you. It is possible to install the JRE in your own directory space.

Below in Sections 2.2 and 2.3 the details of the installation of the OT using Java Web Start and the tarball
installation are discussed. If you are a user participating in a user test, or if you otherwise wish to test the OT,
then please follow these installation instructions. Independent of the installation method used, the OT will be
installed with a default configuration suitable for the general user.

2.1.3 Disk Space Required

To install the ALMA Observing Tool via Java Web Start or by unpacking the tarball requires approximately
100 MBytes; including the Java Runtime Environment (see below) makes the distribution somewhat larger. If
Web Start is used to install the OT, this space must be available in the location where your Java Web Start is
configured to install downloaded applications. The default for this will be a subdirectory of your home space
(Unix/MacOS/Linux) or in the profile area (Windows). In case of a tarball installation the disk space must be
available in the location where the OT will be installed.

2.2 The Java Web Start Installation

The Web Start application has the advantage that the OT is automatically downloaded and installed on your
computer. However, OpenJDK versions of Java such as the "Iced Tea" flavour common on many modern Linux
installations have proved to be problematic and thus we recommend that the distribution from Sun (now Oracle)
be used instead. In the event that Web Start cannot be used, a tarball version if also provided.

2.2.1 Verifying Java Web Start

Installing and running the ALMA OT using Java Web Start requires that Java Web Start is installed on your
computer (Java Web Start comes with JRE 6.0), and that it is properly configured. Further, the browser has to
know to start up Java Web Start when a .jnlp file is downloaded. To verify that Java Web Start is correctly
working one can point the browser to:

http://java.sun.com/javase/technologies/desktop/javawebstart/demos.html

and try to launch one of the demos. In the case it does not work, you may need to configure your web
browser.

2.2.2 Starting the OT

To download and run the OT with Java Web Start please go to the ALMA Science Portal:
http://www.almascience.org

When selecting the OT Java version the browser will download and start the OT.jnlp file, provided that
Java Web Start is configured correctly. In the case of Windows and Gnome 2.0, and depending on your settings,
an icon of the Web Start OT application is placed on the Desktop. Mac users will be asked where to place the
shortcut, but using the Desktop is recommended. The actual OT software will be automatically placed into a
specific subdirectory on your machine.

As part of the download process, a dialogue should appear that states that “The application’s digital signature
has been verified.” This confirms that the OT has been downloaded from a trusted source and that you should
have no security worries about installing the OT on your computer. The screenshot should look very similar to
that in Figure 2.1. Tick “Always trust content from this publisher”, if this has not been done automatically, and
continue with the installation.
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Figure 2.1: The dialogue that confirms that the OT is a trusted piece of software.

2.2.3 Running the OT offline

If you have downloaded the OT and wish to run the software later when not on the network or not from a
browser, then you may do this from the Java Application Cache Viewer. You can start the Java Application
Cache Viewer by running the javaws or binary (possibly with the option -viewer) – remember that you may
need to specify the full path. The Java Application Cache Viewer will display Java applications that are locally
available. If you have downloaded the OT successfully earlier, the OT icon will be displayed in the GUI of the
Application Viewer. An example of what the Java Application Cache Viewer looks like is provided in Figure 2.2.

.

Figure 2.2: An example of the Java Application Cache Viewer. The viewer displays the Java applications that
are available locally. If a network connection is available, a more recent version of an application (provided it
exists) can be downloaded and run.

Click on the ALMA Observing Tool icon and on Launch Offline and off you go. By doing so, Java Web
Start will not try to make a network connection and to find a more recent version of the OT. Alternatively,
when clicking on Launch Online, a more recent version – if available – will be retrieved and launched. Actually,
independent of the Web Start or tarball method, the OT checks that the version that is running is indeed current.
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2.3 Tarball Installation

2.3.1 Installation

The tarball version of the OT must be installed manually and does not automatically update itself when a new
version is released. However, if there are problems with Web Start, it provides a backup installation method
that should always work. In addition, a download of the OT is provided for Linux users that is complete with a
recommended version of the Java Runtime Environment. Please use this if you have any problems running the
OT tarball install with your default Java.

To install the OT using the tarball distribution please the follow the steps given below.

1. Download the OT tarball via the Science Portal and store the tarball in the directory of your choice. Note
that the tarball is available in .zip and in .tgz format. Choose the one that is most convenient for you.

2. Unpack the tarball in the installation directory you have chosen in Step 1.

3. Read the README.txt available in the installation directory and follow the post-installation setup in-
structions contained therein for your platform.

The post-installation setup for Linux and MacOS is as follows:

> cd ALMAOT-Cycle1/setup
> ./Setup-Linux.sh
> cd ..

The setup is very similar for Windows except that the file that must be run will be named “Setup-Windows”, or
“Setup-Windows.cmd”.

2.3.2 Starting the OT

For both Linux and MacOS, the OT can be started using the script that is in the directory in which you unpacked
the tarball distribution:

> ./ALMA-OT.sh &

Note, that you can also add the OT installation directory to your path and run the ALMA-OT.sh script from
anywhere. If you’re on MS Windows, double-click "ALMA-OT" (might read "ALMA-OT.cmd").

Performing the above will issue a number of messages in your terminal window and finally start the OT. The
script will also create a .almaot folder in your home directory, containing the user’s preferences and a log file
(ot.log). The latter contains useful debugging information, but is overwritten each time the OT is started and
therefore should be saved before sending an error report.
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Chapter 3

Basic Concepts

3.1 Phase-1 Proposals

The very first item to work on for obtaining ALMA observing time is the creation of an observing proposal
that successfully passes scientific and technical evaluation. The emphasis of the information provided is on the
scientific requirements as opposed to the technical details of the telescope’s operation.

Key components of a Phase-1 proposal are Science Goals, each of which, broadly speaking, encompasses
one task the user wishes to perform e.g. an observation of a number of sources at a particular frequency at a
particular resolution. Each Science Goal contains a number of pages, each of which covers a different aspect of
the proposed observations, including the source list and the spectral setup.

3.2 Phase-2 Programs

After the successful submission of a Phase-1 proposal and having obtained observing time, the complete set of
technical details of the observations need to be defined. This information is contained within Scheduling Blocks
(SBs) and the creation of these is the heart of the Phase-2 process.

The OT provides two methods for creating Scheduling Blocks: they can either be created by allowing the
OT to automatically generate them from a Phase-2 Science Goal (essentially identical to a Phase-1 Science
Goal), or this can be done manually. The latter is not for the faint-hearted and is usually only carried out by
observatory staff. Successful proposals will have had their Phase-1 Science Goals automatically copied to their
Phase-2 counterparts and SB generation is the standard way of producing the SBs in this case.

3.3 Science Goals

Science Goals are integral to the definition of a Phase-1 proposal as they describe the observations that are to
be performed. In order to make applying for time as easy as possible, Science Goals have been designed such
that it is unnecessary to have a deep understanding of the technical details of an instrument as complicated as
ALMA, or of interferometry. Therefore, a Science Goal takes as input the scientific aims of an observation i.e.
the sources and transitions that are to be observed and the required sensitivity and angular resolution. How
these goals are to be achieved in practice should not necessarily concern a user and the OT will ensure through
its validation process that only proposals that are technically feasible can be submitted.

As already said, Science Goals come in two varieties, Phase-1 and Phase-2. Both look, and to all intents and
purposes are, identical. The main difference is that, if the SBs used to perform the observations are automatically
generated, this is done using the Phase-2 versions only. For expert users, Phase-2 Science Goals aren’t necessary
to produce SBs, but their use is definitely recommended.
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3.4 Scheduling Blocks

Scheduling Blocks are the key executable units of a project and contain all information necessary to execute
a “single” observation i.e. the SB is the quanta of the ALMA scheduling system. It is expected that SBs will
typically last one hour, this relatively short time required to take advantage of rapidly changing atmospheric
conditions at the ALMA site. Therefore, SBs will often be repeated several times in order to achieve the desired
sensitivity and will in general not be executed consecutively.

The SB contains a huge amount of information, including detailed information about e.g. the receiver and
correlator setup that have usually been automatically generated from the scientific constraints entered in the
Science Goals. Calibration information will also have been created, usually in the form of “calibrator queries”
that prompt the telescope control system to search for a suitable calibrator at execution time based on a set of
constraints.

If an SB has been automatically generated, it is still possible to edit the various parameters if required,
although this may not be possible for general users of the telescope. Manual creation is a particularly laborious
process and is intended for experienced observers and for observatory staff for developing and testing new
observing modes.

3.5 Observing Unit Sets

Depending on the user inputs in a Science Goal, multiple Scheduling Blocks might result e.g. both the 12-m
array and the ACA might be required and these cannot be observed with the same SB. These are grouped within
folders called Observing Unit Sets (usually abbreviated to ObsUnitSet or OUS). Every Science Goal will have a
single top-level OUS and at least one OUS within this. It is this second level of OUS that contain the SBs.

One of the main purposes of ObsUnitSets is to define relationships between different SBs for data processing
(e.g. invert and image data from SBs A and B together). The data processing pipeline for SBs is only triggered
when all of the SBs inside an individual ObsUnitSet are marked as completed, unless other conditions apply to
finish the observation.

3.6 Project Submission

Phase-1 proposals and Phase-2 programs are submitted to the ALMA archive in Chile, with each submission
resulting in an email acknowledgement being sent to the PI and all co-Is. Multiple submissions are possible,
including overwriting a project in the archive with an older version that was saved to disk after a previous
submission. Note that each submission causes a timestamp to be written into a project and, if the archive
notices that the timestamp in the current submission is older than that of the version stored in the archive, a
warning will be issued. Once submitted, projects can be retrieved from the archive using a search interface.

3.7 Project Validation

In order to ensure that the user’s specifications for an observation are indeed possible, in particular that they
satisfy the capabilities for the current cycle, the OT provides a number of validation checks. Part of the validation
is performed automatically when observing parameters are entered and invalid input will be immediately coloured
red. Other warnings will also appear without any intervention by the user, particularly to do with the spectral
setup.

A complete validation is only possible by requesting this manually, most conveniently by using the icon in the
toolbar. ALMA proposals and programs can only be submitted to the ALMA archive if there are no validation
errors. Therefore, it is essential to check the validity of the input regularly. Regardless of this, a separate
validation will be performed at submission time, thus ensuring that no invalid proposals can make it into the
server.
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3.8 AOT files

When saving a project to disk, the file that is written will have an aot extension and is usually referred to as
an “AOT file”. This is actually a zip file that contains the various components of a project, including the XML
descriptions of the proposal, project and SBs, as well as the PDF file that will have been attached to provide
a scientific and technical justification. Therefore, it is possible to “unzip” an aot file to get at these individual
components, but this should only ever be necessary for expert users. AOT files can be emailed to other people
for viewing in the OT, but once a project has been submitted, a co-I can also retrieve it from the ALMA archive.
Under no circumstances should a project be altered by editing the XML directly!

3.9 Project Conversion

When importing a project from disk it is scanned to see if it is a project created with the current version of
the ALMA Project Data Model (APDM). This is a protocol that describes every piece of information contained
within an ALMA project and is usually different for different versions of the OT. If the imported project was
created using a different version of the APDM compared to that used by the OT that is trying to read it, an
attempt will be made to convert it to the current version. If the upgrade is successful, the project will import
successfully and future saves will also conform to the new model. However, the imported project is unlikely to
successfully validate, usually because the new model requires information that was not present in the previous.
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Chapter 4

Overview of the Observing Tool

This chapter provides a brief overview of the layout of the OT and how it is operated. The OT is a fairly
complicated piece of software, in that it contains many different input pages, organised and accessible from a
number of different panels. For the novice user particularly, it is recommended that this chapter be read in order
to become familiar with the layout and various important functions and features.

4.1 Help

A number of different ways of receiving help during an OT session are provided. These include:

• User Manual (this document) – provides comprehensive information about how to create a project, including
its main constituents, Science Goals and Scheduling Blocks.

• OT Quickstart Guide – provides a description of how create a Phase 1 proposal in 10 easy steps.

• Reference Manual – gives a brief description of every button and input field.

• Contextual Help – the “question mark” symbols scattered throughout the OT take you to the relevant
section of the Reference Manual.

• Tooltips – placing the mouse over an input field will reveal a short description of its purpose. The length
of time that each is visible is viewable from the Preferences menu.

At the top of the OT GUI, at the right, you will find the Help button. This provides access to the User Manual,
the Reference Manual, the OT Quickstart Guide and general information about the OT. In the OT Help, the
User and Reference Manuals provide a table of contents, are fully indexed and have search a facility. Also, a list
of favourites can be created.

4.2 The OT Main Graphical Interface

Once you have successfully started the ALMA OT, it should look similar to Figure 4.1. It contains three major
components: a menu bar at the top, a toolbar just below this containing the most frequently used functions,
and finally a number of panes, the most important of which allow access to, and the construction of, an ALMA
project.

4.2.1 GUI Parameter Fields

The OT contains a large number of text and numerical input fields, many of which require units (e.g. angles,
temperatures, fluxes, etc.). Units for the parameters fields can be selected from a drop-down list located to the
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Figure 4.1: The Observing Tool main GUI.

right of the input field. When changing the units with the mouse combined with holding down the Alt key, the
quantity will be converted to that unit. Changing the unit without pressing the Alt key will change the unit
only. For example, if you have an angle of 1 arcmin, changing the arcmin to arcsec in the drop-down list without
the Alt key will result in an angle of 1 arcsec. Changing the arcmin to arcsec on the drop-down menu whilst
pressing the Alt key, will result in an angle of 60 arcsec.

When a text field is selected (with the cursor or by tabbing into it), then by default the text in the field will
now be selected. Typing anything will replace the value in the field. Changing this, so that new text is initially
inserted into fields rather than replacing a field, can be done via the Preferences menu.

4.2.2 GUI Features

The use of the OT relies heavily on selecting and manipulating items by means of standard GUI conventions such
as mouse-driven positioning of the cursor or mouse-button clicking to select elements. Standard operations such
as cut, copy, and paste, as well as drag-and-drop and other operations are all implemented and work basically
in the same way as on most windows-based platforms.

Cut, copy and paste can be used on practically any item within the OT, including parameter fields and nodes
within the Project Structure tree. For the latter, the act of copying will often cause the copied item to change
colour (probably to pink). The usual modifier buttons will work, usually the Control key. For Mac users, the
situation seems to be complicated: both the Control and Command keys will probably work when working with
Project tree nodes, but when dealing with parameter fields, Control must be used. The copy of an object will
usually have the text "Copy of" prefixed to its name.

Dragging and dropping will usually work where it makes sense – a very useful application is copying pages
from a Science Goal into another Science Goal, replacing what was previously there. It is not possible, for
example, to drop an ObsUnitSet into a SB.
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4.2.3 Menu and Toolbar

The Menu bar (Figure 4.2) gives access to a variety of OT functions and tools that are more-or-less self-
explanatory. One that all users should be aware of though is the Preferences menu that is accessed through
the File menu. This gives access to a large number of configuration options, including the ability to turn user
privileges on or off. This requires a password and will cause a number of the options within the OT, including
menu and toolbar items, to change.

Figure 4.2: The menu bar and toolbar are displayed at the top of the OT window. This example is for someone
who has user privileges turned on.

The toolbar (also Figure 4.2) contains buttons for executing frequently-used OT functions and tools. Only
those buttons are enabled that can be applied for the selected node in the Project tree. Unfortunately, not all
of the icons are necessarily self-explanatory although each has an associated tooltip. The validate button is a
particularly useful shortcut as this should be pressed at regular intervals.

4.2.4 The OT Panes

The area below the menu bar and toolbar is divided into a number of panes. Each of these has a couple of tabs
that determine which information is displayed and the position of these (bottom or top) can be controlled via
the Preferences menu. The panes can be collapsed and expanded by the small arrows on the boundaries of the
panes.

4.2.4.1 The Project Structure Pane

Each ALMA project consists of a number of different items, including Science Goals, ObsUnitSets and Scheduling
Blocks, that are arranged in a hierarchical tree structure which can be viewed in the Project Structure pane (also
known as the Project tree). Each item in the tree is known as a node and, when selected, will allow different
information to be viewed and edited in the main Editors pane. It is possible for the Project tree to become
very crowded and it is often advantageous to restrict it to only show down as far as a particular node. Nodes
are opened and closed using the “key” symbols and whole trees below a particular node can be collapsed and
expanded via the right-click menu. The Project Structure pane is shown in Figure 4.3.

The two phases of ALMA projects, Phase-1 proposals and Phase-2 programs, are viewable by clicking the
tabs at the top (or bottom if you’ve changed this in the Preferences menu) of the Project tree pane. The Program
tab is only clickable for approved proposals or for privileged users. When the Proposal tab is enabled, all panes
have a green header bar (the same colour is used for the Phase-1 steps in the Overview pane) and a different
colour, blue, is used for Phase 2. A separate option for privileged users allows a commissioning project to be
created, this using a purple colour.

The Project Structure pane can be split into a number of sections. The top section always contains the
project that is being worked on (either the Phase-1 or the Phase-2 tree). In the sections below, templates can be
loaded, either from the ALMA Template Library, or from an existing project on disk. You can display several
projects in parallel. Note the grey background of the template sections, indicating that the content is read-only
and cannot be changed. With the OT, you can copy parts of the templates into the project that you are working
on. The project that is being worked on is visually highlighted and its title displayed in the title bar of the
Observing Tool main window.
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Figure 4.3: The Project Structure Pane. Visible is the structure of a Phase-1 proposal with two Science Goals
(top) and a project that has been loaded as a template (bottom).

4.2.4.2 The Editors Pane

The Editors pane is the main interface that is used to specify a project. It actually contains three separate
editors: Spectral, Spatial and another which is usually referred to as the Forms editor. These are selectable via
the tabs although the Spectral and Spatial editors are only viewable when it is appropriate to do so e.g. when
a Science Goal’s Spectral Setup or Field Setup page is active. The Forms editor is always available to receive
input and is also visible when using the Spatial or Spectral Editors. The name of the tab changes to reflect the
currently chosen node in the Project tree.

Both the Spectral and Spatial tabs give access to graphical interfaces that are extremely useful for viewing a
spectral setup, as well as for viewing and defining a field setup. It is highly recommended that these always be
viewed when creating an ALMA project.

4.2.4.3 The Feedback Pane

The Feedback pane is intended to help the user to act on errors and warning messages that are revealed after the
project is validated. It is not possible to submit a project to the ALMA archive if there are any errors (warnings
are allowed) and so it is extremely important to validate before submission and, preferably, regularly during a
project’s creation. The Feedback pane appears automatically when the validation command is executed, even if
it has previously been hidden.

Upon validation, the feedback can be inspected in three tabs: Validation, Validation History and Log. The
former is the one that is usually used and gives a row listing of the errors and warnings found during the most
recent validation. The location of each problem is indicated by a cross on a red background in the Project tree
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and double-clicking on the row will cause the location to be displayed in the Editors pane.

4.2.4.4 The Overview Pane

Figure 4.4: The Overview panes for Phase 1 (top) and Phase 2 (bottom). The text on the left reflects the project
phase that is selected on the right.

The Overview pane at the bottom of the OT window outlines the steps for preparing a new Phase-1 proposal
or Phase-2 program. Clicking on the arrows will bring up a help listing which may also include clickable links to
perform the necessary steps. It is recommended that this panel be minimised unless you are a novice user.

4.3 OT Configuration

Figure 4.5: The GUI of the OT for setting the user preferences. The Appearance tab has been selected.

The OT supports a number of layout and display configurations that can be selected by the user. The most
basic configuration option is that you may collapse the various panes in the main GUI window and/or change

19



their size. Collapsing can be done via the small arrows next to the pane borders; the border themselves can be
moved using the left cursor button. These changes are automatically maintained the next time you run the tool.

Additionally, using the Preferences menu a large number of OT settings can be specified, mostly to do with
the OT’s appearance and behaviour. The dialogue is shown in Figure 4.5. Particularly useful options include the
time that each tooltip is displayed for, whether a Science Goal is displayed as a summary table or a collection of
all its editors, and whether the OT should display Spatial, Spectral or Forms editors by default.

Other features of the Preferences menu include:

• Dialog behaviour – the OT displays many dialogues during its operation, often to confirm if a particular
operation is really required. At the risk of making mistakes, it can be advantageous to switch some of these
off using the Dialogs tab. This is particularly useful for people who do a lot of work with SBs.

• User credentials – if they have already been entered, e.g. to submit a project to the ALMA archive, or to
enable user privileges, the username and password will be displayed here. These details are remembered
by the OT and will persist across OT sessions.

• User privileges – if a user has an account with special privileges, these must be activated using the Advanced
tab. Once this is done, the OT will prompt for the username and password each time it is started. Note
that this means it is not possible to use the OT with user privileges without a network connection!

All user preferences are stored by the OT in the $HOME/.almaot directory and will be used when starting
the OT.
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Chapter 5

Tools and Simulators

The OT has a number of tools to help users plan observations. In particularly, they facilitate: calibrator
selection, LO configuration, calibrator time estimation and spectral line selection. The OT also includes the
ALMA Sensitivity Calculator and a template library.

5.1 The ALMA Template Library

The purpose of the ALMA Template Library (Figure 5.1) is to provide a set of Science Goals that cover different
proposal types. Once the Template Library is opened (via the File or View menus), the Science Goals within can
be inspected in situ and items within it individually copied and pasted (or dragged and dropped) into an existing
Science Goal in a proposal that is being worked on. Alternatively, a complete Science Goal can be copied into
an active proposal and then edited as normal.

The Science Goals within the Template Library are based on the projects contained within the ALMA Primer.
A user’s own projects can also be used as templates and are opened as such (in read-only mode) from the File
menu.

Figure 5.1: The ALMA Template Library.
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5.2 Sensitivity Calculator

The ALMA Sensitivity Calculator is most easily accessed via the obvious icon in the toolbar. It will calculate
the time required to reach a certain sensitivity, or vice versa, and can be separately configured for the 12-m, 7-m
and TP arrays. An identical version is available as a web applet in the Science Portal.

Figure 5.2: The ALMA Sensitivity Calculator.

After having defined the input parameters (Observing Frequency, Bandwidth, Water Vapour, etc.) in the
common area in the upper part of the interface, using the number of antennas and required sensitivity, the tool
now calculates the integration times for the ALMA 12-m array, the ACA 7-m array and the ACA Total Power
array. Note that the numbers of antennas will be set to their default values for the present Cycle. The tool also
provides the inverse facility, i.e. estimating the sensitivities given an input integration time. The layout of the
Calculator is displayed in Figure 5.2.

In the GUI, the user has to specify the bandwidth per polarisation. Multiplying this number by the number
of polarizations gives the effective bandwidth. Sensitivity is treated as a flux density for point source detection
if the unit is either Jy or mJy, and as a brightness temperature of an extended source if the unit is either K or
mK. Therefore, an angular resolution must be entered if temperature units are to be used. Note that system
temperature and atmospheric parameters are displayed for the specified frequency. There are 7 octile choices
(0.472 mm, 0.658 mm, 0.913 mm, 1.262 mm, 1.796 mm, 2.748 mm, and 5.186 mm) for the Precipitable Water
Vapour (PWV) and these can either be selected manually, or chosen automatically by the calculator. It is very
important to realise that changing the PWV from its default value in the ASC has no effect on the OT’s time
estimate for your project. This uses the ASC code, but always chooses the automatic PWV option.

When the user enters a flux density sensitivity, a brightness temperature equivalent to the flux density value
is also displayed, if an angular resolution has been entered. Conversely, when a surface brightness is entered,
a flux density equivalent to the surface brightness value is displayed. Finally, Integration Time Unit Option
allows a choice between the calculator automatically choosing an appropriate unit (recommended) or specific
user-defined units.

A much more detailed guide to the ALMA Sensitivity Calculator can be found in the ALMA Technical
Handbook.

5.3 Spectral Line Selection Tool

The ALMA spectral line catalogue contains the rest frequencies of millions of spectral line transitions. These
transitions can be inspected and selected via the Spectral Line Selection tool. The initial list of molecules was first
compiled using David Woon’s website at: http://www.astrochymist.org/astrochymist_mole.html. This list
was followed up and information from the published literature added. A subset of the complete catalogue is
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Figure 5.3: The ALMA Spectral Line Selection Tool.

packaged with the Observing Tool, which should be sufficient to select some of the most commonly targeted
transitions, even when working offline. If network connectivity is available, access to the complete catalogue
becomes possible using the online search functionality of the tool.

The tool is available either when creating a Spectral Setup in a Science Goal (see Section 6.3.3) or an
Instrument Setup in a Scheduling Block (Section 8.4.3). In both cases, the selected transitions can be used to
define observed frequencies as well as being available to overlay on the Visual Spectral Editor.

When the transition selector dialogue is launched, the offline spectral line catalogue is displayed and every
transition in the catalogue is available for selection. Specific transitions can be located by using the controls in
the left-hand panel to set your search criteria. String matches to the transition name or description are possible,
as is matching by frequency and ALMA instrument band by dragging the range sliders or using the frequency
input boxes. The string matching is not standard: a bare piece of text will only match the beginning of a string,
but if a wildcard (’*’) is placed at the beginning, the text will match anywhere (and not just at the end). Note
that the frequency slider refers to sky frequencies (these are calculated using the velocity of the first source in the
Science Goal). Double-clicking on the column headings will cause the table to be sorted according to the values
in that column (large triangle) and clicking a subsequent column will cause a secondary sort (small triangle).
The triangles indicate the direction of the sort and subsequent single clicks will reverse this.

If a desired line cannot be found in the offline catalogue, it may exist in the more extensive online catalogue.
The online catalogue can be queried by clicking the “Find More...” button; the query will use the species filter
and the frequency limits only and wildcards are not allowed. The results of the query will be added to
the list of selectable transitions, and will persist as part of the offline database for the rest of the
observing tool session.

Having located a target transition, it can be copied into the table of selected transitions by selecting it and
clicking the obvious button, or simply by double-clicking. When creating a spectral setup, only one line can
be chosen at a time. However, when overlaying, multiple lines can be copied simultaneously into, and removed
from, the table of selected transitions, by highlighting multiple rows. Closing the tool using the “OK” button
will cause the selected frequencies to be entered into the OT.

A very important part of the Line Picker is its ability to only allow lines to be selected that can be observed
together in a single tuning solution. This “unobservable lines” filter is enabled by default and calculates the
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range of frequencies for which a line could be entered to the currently defined list of spectral windows (even if
they are in other basebands) and still result in a valid tuning. In overlaying mode, it instead restricts the list to
those lines that could fit the current tuning solution. Note that this feature makes no allowance for the width of
a spectral line so it is important to check that all spectral lines are properly covered by their spectral window.

5.4 Calibrator Selection Tool

Calibrators can be added to both Phase-1 proposals and Phase-2 programs using a standard calibrator search
tool, although the details of how this works differs slightly in the two cases. Two catalogues can be searched: the
full ALMA calibrator database that is searched online, or a much more limited version (smaller and not so up-to-
date) that is contained within the OT and thus can be searched even in the absence of a network connection. The
former is of course recommended and is the default. The internal catalogue is basically a snapshot of the SMA
catalogue taken a few years ago and contains measurements at 3, 1 and 0.87 mm. The ALMA catalogue also
contains these SMA data, but also VLA measurements at lower frequencies. Most importantly, new measurements
taken with ALMA are now constantly being added.

Figure 5.4: The Calibrator Selection Tool as used in the Calibration Setup of Science Goal. A search has been
made for all calibrators within a 10-degree radius of a source position, that have a flux greater than 500 mJy in
ALMA Band 3.

The search interface is shown in Figure 5.4. Calibrators are found by matching a set of search criteria,
consisting of the centre position and radius of a cone search and a set of minimum and maximum values for the
flux as well as the frequency over which this is valid. Criteria are enabled by the presence of non-zero values and
a symbol next to the field will give a visual sign of whether a particular feature is enabled or not. Searching with
all filters disabled will return the entire catalogue! A final field sets how many matches will be returned. From
the total number of sources that match the search criteria, these will always be those with the lowest values of
Right Ascension.

Once the search constraints have been entered, either the ALMA online catalogue or the internal OT catalogue
can be searched by clicking the “Submit Query” button. As with many other tables in the OT, the results can be
sorted by clicking on a column header; the direction of the arrow indicates the sort order which can be reversed
with subsequent clicks. Secondary sorts are not possible. Alternatively, the OT’s list of non-sidereal calibrators
can be displayed.

The calibrator tool can be accessed in a number of ways. At Phase 1, it is only available when defining a
user-defined calibration in a Science Goal. However, at Phase 2, it is also available from the Tool menu and from
within a Field Source definition. In all cases, the search interface itself works identically, although the details of
how a chosen source is used vary. Please consult the relevant sections of this manual for more information.
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5.5 LO Configuration Tool

Figure 5.5: The LO Configuration Tool. Three Band-9 basebands have been requested with the tuning results
shown at the bottom.

For expert users only. Available from the Tools menu, the LO Configuration tool is an interface to the
algorithms used by the OT to generate tuning solutions. At its most basic, the centre frequencies of up to four
basebands can be entered and a tuning solution (LO1 and LO2 frequencies) requested. Figure 5.5 demonstrates
the use of this tool to derive a tuning solution for three basebands at Band 9.

5.6 Calibration Time Estimate Tool

For expert users only. The OT calculates the calibration overheads as part of its time estimate and this
tool was built to help in the implementation of this feature. It allows various parameters to be entered and the
required dwell and cycle times for a variety of calibrators to be displayed. This tool can be seen in Figure 5.6.
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Figure 5.6: The Calibration Time Estimate as used to calculate the required time on source for an amplitude
calibrator.
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Chapter 6

The Phase-1 Observing Proposal

This chapter guides you through the steps needed to produce a Phase-1 proposal that can be submitted to the
ALMA archive. To follow the descriptions, it is recommended that you have an open OT session in front of you
at the time of reading.

6.1 Open a Phase-1 Proposal

Firstly, a proposal must be loaded into the OT, either a completely new one, or one that has previously been
saved to a local disk or stored in the ALMA archive. This can be done using either the File menu or the toolbar.
When loading or starting a new proposal, dialogue boxes will warn about possible overwriting of the current
project if it has unsaved changes.

The first task is to provide some generic information about the project. Selecting the Project node in the
Project Structure tree will enable both the PI to be chosen, by querying the ALMA User Database, and a title
for the project to be entered, although both can in fact be entered in the subsequent Proposal node. Once the
project title has been entered, this will be reflected in various places in the OT: the main GUI titlebar, the
Project node and the Forms tab of the Editors pane. A non-editable project code will initially be blank and only
be completed once a proposal has been submitted for the first time. The Project form is visible in Figure 6.1.

Note that privileged users will also see panels entitled Project Notes and Advanced Options. Amongst other
things, these enable observatory staff to gain access to restricted information about a project (including the
outcome of its scientific and technical review) and to note useful information.

Figure 6.1: The Forms editor for the Project node, as seen by an unprivileged user.

To continue with proposal creation, the Proposal node in the Project tree should now be selected. A number
of information fields should be visible in the Editors pane and double-clicking on the node will reveal an empty
node named Planned Observing; the Phase-1 Science Goals are kept here. Also note that on top of the Project
tree, in the blue banner, the status of the proposal is visible. For newly created proposals it will say "Unsubmitted
Proposal" whilst proposals that have already been submitted will show "Submitted Proposal". If this message
is visible, submission of the proposal will overwrite the previous submission!
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6.2 The Proposal Form

When the Proposal node is selected, the Proposal form is loaded in the Editor pane (Figure 6.2). The form
contains roughly a dozen fields for describing the proposal, including an abstract, proposal type, scientific key-
words and investigator information. Completing the information should be straightforward and the meaning of
the fields, and whether they need to filled in, self-explanatory. Note though that the proposal type can only be
edited for proposals before their first submission – after this, no further edits are possible. The available proposal
types are:

• Standard: for proposals that require < 100 hours of observing time

• Target Of Opportunity: For proposing the observation of an unpredictable sudden astronomical event, such
as a Gamma-ray burst.

Once the Science Category has been provided, a list of keywords appears, the content of which depends on which
category has been picked. At least one, and up to two, can be chosen and the Shift and Control/Command keys
can be used to select multiple entries in the usual manner. Related proposals should be listed in the two boxes
below the keywords. One box is for proposals from this Cycle and the other from previous Cycles. In each case
the project code, title and PI name should be given.

Figure 6.2: An example of the Proposal form. A single scientific keyword has been chosen.

6.2.1 Adding Investigators

Further down the page is a panel for adding the details of the Principal and Co-Investigators – these must all
have registered in the Science Portal before they can be added in the OT and we strongly advise that this is
done well in advance of the proposal deadline.

A project can have only one PI, but any number of Co-Is. Clicking on e.g. “Select PI...” will start-up a
window (Figure 6.3) which allows you to search for and select users from the ALMA user database. Within
this, users can be identified by their name, email address or ALMA ID (username). To find matching users,
select which attribute should be searched from the drop-down list, enter a valid constraint into the text field and
click “Find Investigators”. If the entered constraint is invalid, it will be highlighted in red and searching will be
disabled. A valid constraint consists of:

• Name: at least 3 characters (partial matches are reported)

• ALMA ID: at least 3 characters (only exact matches are reported)

• Email: a valid email address (only exact matches are reported)
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All searches are case-insensitive and multiple queries can be performed in one go by entering search terms
separated by commas. In case only one result is returned, it will be automatically highlighted for convenience
and double-clicking a single row is a handy shortcut to enter this user into the table of investigators (Figure 6.4).
In the case of co-Is, highlighting multiple entries will cause these to be entered into the table – removing them
works in the same way.

The last column in the table shows a user’s Executive. Currently, the Executive of the PI determines whether
the time required for a project is charged to the East Asian, North American or European share of available
observing time and is usually set at the time of registering in the Science Portal. Taiwanese investigators though
must set this in the OT as they can decide, per proposal, between charging all of the project’s time to NA or EA,
or to split it evenly between the two. Although this only has any effect for PIs, the OT still allows a Taiwanese
co-I’s Executive to be set in this way.

When there are many investigators, adding them all can be very irksome. Fortunately, if you have a previous
proposal that contains all or some of the desired investigators, these can be imported using the “Add from
Proposal...” button. The project in question must exist on the local disk and once selected, its investigators will
be added to any that have already been selected.

Figure 6.3: The investigator search dialog to select a proposal’s investigators from the ALMA user database.

6.2.2 Scientific and Technical Case

Below the list of investigators, the PDF document to support the science case must be attached. This is limited
to a maximum of 5 pages, must not exceed a total size of 20 Mbytes and must include a technical justification.
Figures can be included if desired. Once attached, the PDF file can be removed and replaced with another and
can also be viewed, provided that your computer contains appropriate software.

Figure 6.4: The lower part of the Proposal form with investigator details and attached scientific justification.
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6.3 Adding Phase-1 Science Goals

Once the administrative information has been added, it is now possible to insert the core of every ALMA proposal,
the Phase-1 Science Goals. Up to five Science Goals can be added in a number of ways, but perhaps the
most convenient is by using the toolbar icon. Each time this is clicked, an empty Science Goal will appear
underneath the Planned Observing node and by default each will show its five sections (Figure 6.5). Note that
a Science Goal can only be added if either the Proposal or Planned Observing nodes are currently active.

A number of summary views of the defined Science Goals are available. The first is a table that is visible
when the Planned Observing node is active – each row gives a brief description of each Science Goal. If the top
node of a Science Goal is selected, what is displayed depends on what has been set in the Preferences menu. The
choices are a similar table to that displayed in Planned Observing or a view of all five sections of a Science Goal
simultaneously.

The five sections of a Science Goal are: General, Field Setup, Spectral Setup, Calibration Setup, and Control
and Performance. These will now be discussed in detail.

Figure 6.5: Project Structure tree for a Phase-1 proposal with two Science Goals.

6.3.1 General

The Science Goal name and a description of the Science Goal can optionally be completed using the text fields
in the General form. To edit the description, it is most convenient to type directly into the text field, although
it is also possible to launch a sophisticated text editor (jEdit).

6.3.2 Field Setup

6.3.2.1 Source properties

In the Field Setup page, the user is asked for source parameters, such as a name, coordinates (which must be
specified in the J2000 system), velocity and proper motion. The source names should only contain the following
characters: a-z, A-Z, 0-9, -,+, _ or a . (full stop). Characters other than these will be removed or replaced when
the project is validated. Regarding proper motions, the components in the Dec. and R.A. (cross declination)
directions are both true angles on the sky and are used to convert the given source position to an observable one
assuming that it refers to epoch 2000.

The ALMA telescope control system recognises a limited number of solar system objects that can be selected
from a drop-down list. This same list also allows the use of an ephemeris for any object for which the coordinates
as a function of time can be provided. This is loaded as a text file from the local disk and must be in the
JPL HORIZONS format. For details on how to generate HORIZONS ephemeris files, please check Appendix B.
When using an ephemeris, it is recommended to use minimum time intervals of not greater than 10 minutes so
as to keep the file to a manageable size.
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Table 6.1: Example format for a ASCII source list that can be read into a Science Goal.

Source Name, RA(sexagesimal) , Dec(sexagesimal), PMRA (mas/yr), PMDec(mas/yr),
Velocity (km/s), velocity reference frame, peak continuum (mJy), peak line flux (mJy),
expected polarization (%), expected linewidth (kHz)
-- This signals end of the header
ngc 253, 00:47:33.129, -25:17:17.808, 0.0, 0.0, 244.0, lsrk, 200, 1000, 2, 1500
ngc1068, 23:59:59.266, -00:02:02.774, 0.0, 0.0, 1133.0, topo, 1100.0, 30, 0, 20

The velocity can be specified using the optical, radio, or relativistic convention (default radio). When changing
the source velocity reference system between the available options of heliocentric, barycentric, topocentric, lsr
and lsrk, the OT is not able to convert the velocity and you will be reminded of this via a pop-up dialogue. The
velocities must be sufficiently similar such that all the sources can be observed in a single band. In addition, a
maximum of five tunings per Science Goal are allowed and thus the sources must be grouped in velocity space
in such a way that this limit is not exceeded. The OT will issue an error if this is the case.

Finally, the middle panel contains three fields that can be used during the technical review of the Phase-1
proposal. Although it is sometimes hard to be sure of the values before the source has actually been observed,
in these cases please try and enter reasonable estimates (which would probably have been used in the technical
justification anyway).

The above-described information (except Solar System objects) can be added to a Science Goal from an
ASCII file using “Load from File...”. This can be used to either load a set of additional pointings or to completely
replace the list of currently-defined pointings. The, format of the ASCII source list is shown in Table 6.1; it
should be possible to cut and paste this into a text editor:

6.3.2.2 Resolving source information

The querying (or “resolving” in OT parlance) will work once a source name has been entered. The OT will
first try SIMBAD and then, if no result is forthcoming, NED. It is not possible to select which server is queried
although the OT will state which one gave the displayed result. In the case of SIMBAD, the OT performs a
so-called “basic query”. The safest method is to enter a non-ambiguous catalogue/survey name such as Cen A,
NGC 5128, Arp 153, etc. Catalogue/survey names that include coordinates are okay as well e.g. PKS J1325-4303.

A fairly dangerous kind of resolve criteria is something like J1325-430 (so-called IAU format). This is in-
terpreted as a position around which to search (default radius of 10 arcmin) and will nearly always return the
wrong source, unless the positional accuracy is very high. Additional control can result from adding an object
identifier to the search e.g. J1325-430=QSO will also return Cen A. A final pitfall concerns the proper motions
of bright quasars. The Hipparcos mission measured non-zero values for many of these although, reassuringly,
the associated uncertainties mean that the results are consistent with zero. Nonetheless, it is the measured,
non-zero, values that will be entered into the OT.

Although an extremely useful tool, given the above issues, resolving source information should be used
with care and all details should be checked very carefully. The OT will present a table containing the source
information that has been resolved, before this is entered into the Field Setup form. This will warn the user
if proper motions or a velocity have not been found and will also give the actual name of the source contained
within the database (as opposed to the one that was used for the search). This can be useful for identifying
searches that have gone bad. The user has ultimate responsibility to ensure that the source details
are correct!

6.3.2.3 Field definitions

There are two kinds of field definition in a Phase-1 Science Goal, one or more individual pointings around a
source position, or a single rectangular area. For rectangles, it is not currently possible to define more than one
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source per Science Goal. With multiple pointings, up to 15 sources can be defined, but these must all be within
15 degrees of each other. Depending on which of these is chosen, the contents of the third panel at the bottom
of the page will change.

If multiple pointings has been selected, a list of positions can be entered in a table in the Forms editor
(Fig. 6.6) or can be placed onto an image using the Visual Spatial Editor (Chapter 9). As with the sources
within a Science Goal, the individual pointings within a single source cannot be more than 15 degrees apart.

For a rectangular field, the size and orientation can be entered manually at the bottom of the Forms editor,
or it can be drawn by hand using the Visual Spatial Editor (Chapter 9). Once a rectangle has been defined, the
OT will automatically calculate a mosaic pattern of evenly-spaced single pointings that will cover the defined
area, both for the 12-m and 7-m arrays. The number of pointings for each array will be displayed in the Forms
Editor and displayed in the Visual Spatial Editor. The latter will also display the area that will be scanned by
the TP array if the ACA has been selected. If you would like to use the mosaic pointings in your own software,
or as input to CASA’s simdata task, their positions can be exported to file.

Figure 6.6: The Science Goal Field Setup form with three sources.

The spacing parameter can be specified in either angular units or as a fraction of the antenna beam (“main”
beam), but defaults to the Nyquist value in both cases. This is the value, λ/(

√
3D), that is appropriate for a

hexagonal/triangular mosaic pattern, the OT’s default. As the antenna beam size is 1.2λ/D, the actual value
reported in beam units is 1/(1.2

√
3) i.e. 0.48. Particularly for projects that are mapping large structures, this

should not be changed as it ensures maximum coverage of short u, v spacings. Projects which simply aim to
cover a large area can use larger spacings, but non-uniform sensitivity will eventually result. Therefore, we
recommend that values not greater than 0.8 times the antenna beam size be used and greater than this will
trigger a validation and TA Flag Sheet warning.

Regardless of the how the various pointings have been defined, it is not currently possible to submit a proposal
with more than 150 12-m array pointings.

6.3.3 Spectral Setup

The Spectral Setup page contains fields to specify spectral windows, each of which samples a sources’s spectrum
over a particular range of frequencies. The Forms editor basically consist of panels for the spectral specification,
a feedback area that gives messages when the spectral specs are in error, and a panel that contains the sources
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that have been defined in the Field Setup page. An example is provided in Figure 6.7. An extremely useful
accompaniment to the Forms editor is the Visual Spectral Editor that is described in full detail in Chapter 10.

The first thing to select is the type of spectral observation: “spectral line” or “single continuum”; the “spectral
scan” function is not currently available. The main difference between spectral line and single continuum is
that the latter is basically a shortcut to defining a maximum-bandwidth, low-resolution spectral setup that will
almost certainly be used for observing a continuum only. Spectral line gives you full flexibility in defining spectral
window positions, bandwidths and spectral resolutions.

In addition, the polarisation products must be specified. All ALMA receivers detect linearly polarised radi-
ation and the two orthogonal senses of this are referred to as X and Y. In order to maximise sensitivity, both
the X and Y signals from each antenna are correlated, leading to both XX and YY (“DUAL”) being delivered
for each spectral window. It is usually only necessary to observe in single polarization (XX) if the maximum
spectral resolution is required. Full polarization observations (XX, YY, XY and YX) are not yet possible for
Phase-1 proposals.

6.3.3.1 An introduction to the ALMA backend

ALMA has a maximum of 8 GHz of bandwidth, this being made up of 4 2-GHz wide basebands. Within each of
these, a user is able to place a single spectral window, either a low spectral resolution (TDM; 64-256 channels
over 2 GHz) or a high spectral resolution (FDM; up to 8192 channels over a width that ranges from 62.5 MHz
to 2 GHz) mode. Actually, the real bandwidths are somewhat smaller than this: the FDM modes in particular
are a factor 15/16 smaller than the nominal bandwidth due to the need to overlap the individual 62.5 GHz-wide
filters that together produce wider spectral windows. The total usable bandwidth of any mode is limited to
1.875 GHz due to the anti-aliasing filter.

To make things more complicated, the basebands need to be placed inside the sidebands of the particular
ALMA band that is being used. Even worse, the location (width and separation) of each sideband differs from
band to band, mainly depending on whether they are a two-sideband (2SB) or a double-sideband (DSB) receiver.
Most bands, including Cycle-1 bands 3 and 7, have 4-GHz wide sidebands that are separated by 8 GHz. The final
kick in the teeth is that, for most of the bands, the basebands must be paired i.e. all must go in one sideband,
or two must be in each; a 3/1 split is not possible.

Full details of how this all works can be found in the ALMA Technical Handbook, but it should be clear that
spectral setups can be very complicated indeed, especially given that in the future it will be possible to have
multiple spectral windows and multiple correlator modes per baseband. The good news is that OT understands
the various restrictions and will not allow a spectral setup to be submitted that doesn’t conform to the known
capabilities of the telescope during the relevant Cycle. In addition, the Visual Spectral Editor (Chapter 10) is
an invaluable tool as it displays the ALMA bands, sidebands and spectral windows. Use it!

6.3.3.2 Spectral Line

As said above, the spectral line interface gives maximum flexibility in what can be defined. It will in fact generally
be used to observe spectral lines, although the ability to mix FDM and TDM windows means that a mixture
of high-resolution and low-resolution spectral work and continuum determination can be observed in the same
setup (Figure 6.7).

Within each of the four available basebands, a single spectral window can be specified. Each window can
either be added manually and its central frequency entered by hand, in the sky or rest frame, or else the Spectral
Line Selection Tool (“Select Lines to Observe...”) can be used to search the vast Splatalogue spectral line database
(see Section 5.3) and enter the frequency for you (along with a transition name). Once the frequency has been
defined, a correlator mode (bandwidth and resolution) must be chosen from a drop-down menu that is activated
by double-clicking – the single mode that is displayed in bold text is a TDM. Note that Hanning smoothing is
disabled by default in the ALMA correlator and so the displayed frequency resolution is actually twice that of
the channel spacing.

If the entered frequencies are not able to be observed simultaneously e.g. they do not all lie within the receiver
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Figure 6.7: Example of a Science Goal Spectral Setup Form. In this setup, four spectral windows have been
defined. The first baseband contains an observation of CO in a narrow, high-resolution, spectral window and
was created using the Spectral Line Picker. The other three basebands all contain a single, low-resolution,
spectral window in order to determine the source continuum. They were entered manually and are automatically
described as such by the OT. The CO spectral window has been selected to set the Representative Frequency.

sidebands, an error message will appear in red below the spectral window table and the proposal will also not
validate. Using the Visual Spectral Editor is an excellent way of diagnosing spectral setup errors as it displays the
lines and their bandwidths as well as the ALMA bands and sidebands. When choosing lines with the Selection
Tool, its unobservable line filter will ensure that lines cannot be picked if they can’t be observed simultaneously
with lines that have already been defined.

The final column of the spectral window table selects which is to be used to set the Representative Fre-
quency. This is a very important parameter as it, in conjunction with the sensitivity entered in the Control and
Performance page, sets the total observation time as it determines the opacity that is used in the sensitivity cal-
culation. It also sets the antenna beamsize in the Visual Spatial Editor. If the transition you are most interested
in does not fall in the centre of the chosen spectral window, the Representative Frequency can be changed to
the appropriate value, with the restriction that the edited frequency must lie within the spectral window. The
Representative Frequency interface is also shown in Figure 6.7.

At the bottom of the page is a list of all the sources that have been defined in the Field Setup page and which
are listed together with their velocity specifications and Representative Frequencies. The latter are given in the
sky (observed) frame as this is relevant quantity for determining the observing time for each source. Clicking
on a source will use that source’s velocity for the rest-to-observed frame and velocity conversions in both the
spectral window table and the Spectral Visual Editor.
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6.3.3.3 Single Continuum

The Single Continuum interface essentially provides a shortcut to producing a spectral setup that covers the
maximum possible bandwidth with the lowest possible spectral resolution. After entering a single frequency,
usually in the sky frame, the OT will automatically create 4 2 GHz-wide TDM spectral windows, one in each
baseband, and display them in the spectral window table. For bands that have 2SB receivers e.g. bands 3, 6
and 7, two will be placed in each sideband. For band 9, which is a DSB receiver, all four are placed in the same
sideband.

The Representative Frequency will default to being the central (sky) frequency of the first spectral window.
As with the spectral line interface, this can be changed, both by changing the spectral window and the frequency
within this window. However, it is not possible to change the other parameters of the individual spectral windows.
These can only be changed by editing the single value of sky or rest frequency.

6.3.3.4 Multiple velocities and tuning solutions

In both Spectral Line and Single Continuum cases, it is possible to enter sources with different velocities. For
Single Continuum, this is usually irrelevant as the setup is usually defined in the sky frame and the source
velocities are ignored. For Spectral Line though, the velocities are crucial as these are used to convert the rest
frequencies to their observed equivalents. In general, this means that each source requires its own tuning and
its own set of calibration observations. This greatly increases the complexity and time required to complete a
project and thus each Science Goal is restricted to five separate tunings.

The OT automatically calculates how many tunings are required by calculating a solution separately for each
velocity and then seeing which of the other sources could be observed using this tuning. The result is a minimum
list of tunings required to observe all the spectral lines. The number of tunings is reported in the Time Estimate
dialogue (Section 6.3.5.3).

6.3.4 Calibration Setup

Figure 6.8: An example of a user-defined calibration setup.

The Calibration Setup page allows a user to choose between user-defined and system-defined calibrators. It
is STRONGLY recommended to choose the system-defined option; the observatory will ensure that suitable
calibrators are used.

When user-defined calibration is specified, a table appears (Figure 6.8) in which the calibration sources can be
added, deleted or edited. The initial list of calibrators describes the default calibration scheme for ALMA projects
and appear in the approximate order in which they will be executed. There are three pointing observations and
these are associated with the calibration that appears below them i.e. the first pointing is for the amplitude
calibrator. Atmospheric calibrators (Tsys) are not shown, but do comprise part of the default calibration scheme.
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Two types of calibrator are available: fixed and dynamic. Fixed calibrators request a specific source whilst
the dynamic variant consists of criteria (position, search radius, flux limits) that are used to choose a source
from the ALMA calibrator database at the time that the SB is executed. Dynamic queries can be tested during
Phase 1, but the database is likely to change between proposal submission and program execution.

The main use of user-defined calibration is probably to change some of the default dynamic queries to fixed
calibrators. It is also possible to define additional calibrations and even to remove some of the defaults, but
this is strongly discouraged. Doing so will change the time estimates for a project and must be justified in the
Technical Justification. Simply choosing user-defined calibration will alert the Technical Assessor via the TA
Flag Sheet and deleting or adding calibrations will trigger a validation warning.

6.3.5 Control and Performance

Figure 6.9: Example of the Control and Performance parameters.

The final page of the Science Goal allows the user to enter important scientific objectives such as the required
angular resolution and largest source scale that needs to be imaged. These determine which of the six 12-m array
configurations is required, whether or not the ACA is needed and how much time is required for the observations to
achieve a requested sensitivity given the spectral setup. An example of the Control and Performance parameters
is shown in Fig. 6.9, including the ACA interface.

6.3.5.1 Imaging considerations and the ACA

The imaging goals depend crucially on the baselines of the six configurations and the OT displays the maximum
and minimum baseline lengths of the most compact and most extended configurations and the angular resolution
(λ/Lmax) and maximum recoverable angular scale (0.6λ/Lmin) corresponding to each. Note that the source
declination is not taken into account when calculating these quantities. Also shown is the beamsize of both the
12-m and 7-m antennas (1.2λ/D) the size of which will determine whether multiple pointings are required to
image the requested area. The Representative Frequency that was entered on the Spectral Setup page is used to
calculate λ.

Based on these displayed values, it should be possible to enter the requirements for the proposed observations.
The angular resolution, for example, can lie anywhere between that corresponding to the most extended con-
figuration, and twice that of the most compact configuration. The first limit simply states that it is impossible
to achieve a higher angular resolution than that provided by the largest configuration, whilst the latter reflects
the possibility that an image may ultimately be smoothed. Depending on the entered value, the OT will now
choose the configuration that achieves an angular resolution at least as good as that requested. This choice is
displayed in the “Time Estimate” dialogue (see below).
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As a configuration has been chosen, the OT can now compare the largest angular scale in the source that
you wish to image, with the maximum recoverable angular scale of that 12-m configuration. If it is not possible
to image the requested structures, shorter baselines will be required and thus the OT will recommend that ACA
observations also be scheduled. These will always include the 7-m array – the TP array will normally also be used
unless continuum observations have been requested (the TP antennas do not currently have nutators). However,
if the requested angular resolution is high enough that the two largest configurations are required (C32-5 and
C32-6), the OT will not allow complementary ACA observations as there will not be enough overlap between
the 7-m and 12-m array configurations. Point sources will, of course, never need the ACA.

Whether or not the ACA is required can be tested by clicking the “Suggest” button at the bottom of the
page. This will show a dialogue giving the result, the reasons why the ACA is or is not needed, as well as
automatically selecting or unselecting the ACA as appropriate. As long as the largest 12-m array configurations
are not required, the OT’s ACA choice can be overridden, but this will produce a validation warning and will
need to be justified in the attached PDF.

6.3.5.2 Sensitivity considerations

The time required to achieve the requested sensitivity depends crucially on the spectral setup, particularly the
Representative Frequency (this sets, amongst other things, the atmospheric opacity) and the spectral resolu-
tion. If the sensitivity is requested in temperature units, the angular resolution will also have an effect. The
Representative Frequency should have been chosen to reflect the most important spectral feature that is to be
imaged, although in parts of the spectrum where the opacity is well behaved, which spectral window is chosen
will actually make very little difference to the time estimate.

How the entered sensitivity is interpreted also depends on whether a rectangular area has been selected
in the Field Setup. If so, the sensitivity entered should be that required in the final mosaiced map, not that
corresponding to a single pointing. As the pointings in a mosaic usually significantly overlap, the combined
sensitivity is higher and thus requires less time per pointing to be achieved. For Nyquist sampling, and assuming
a Gaussian beam shape, the sensitivity of a mosaic is 68 per cent better than that of a single pointing and
the time required per pointing is reduced by a factor 2.8. The OT will calculate this factor and use it when
estimating the time for the project. Note, however, that if the requested sampling is significantly greater than
Nyquist, the sensitivity becomes increasingly less uniform and thus a validation and TA Flag Sheet warning is
triggered for separations greater than 0.8 times the antenna beam size.

It is also necessary to define the bandwidth over which the sensitivity should be calculated. This will depend
on the scientific goals, but usually refers to the full bandwidth for continuum observations or to some fraction
of the line width. The OT provides a number of shortcuts for completing this parameter, including “Aggregate-
Bandwidth” for continuum projects (the sum of all the defined spectral windows) and “FinestResolution”, this
referring to the highest (Hanning-smoothed) resolution of any spectral window (and the default for Spectral Line
setups). Finally, a user-defined value is possible. Single continuum setups enforce the bandwidth for sensitivity
to be equal to the total bandwidth i.e. 7.5 GHz. Once this parameter has been set, the OT’s estimate of the
time required for the project can be checked.

6.3.5.3 Time Estimation

Unlike most other radio/mm/submm telescopes, instead of asking for a specific amount of time, a proposal
states a sensitivity that needs to be achieved. The OT then, using an internal version of the ALMA Sensitivity
Calculator, produces an estimate of how long this will take, based on the typical atmospheric conditions in which
the project will likely be observed.

Clicking on the “Time Estimate” button will bring up a dialogue (Figure 6.10) that contains information
relevant to the time estimation calculation. This includes the requested sensitivity and Representative Frequency,
the total number of pointings, whether the ACA is required, the calibration requirements and other overheads.
For Cycle 1, the time required for the ACA has been determined from simulations to be equal to three times the
12-m array time and the OT assumes this multiplication factor, even if the Total Power array will not be used
i.e. for continuum observations.
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The time required for calibration is calculated assuming the following, per SB and tuning solution:

• One amplitude calibrator + pointing

• One bandpass calibrator + pointing

• One phase calibrator + pointing.

There is typically only one observation of the amplitude and bandpass per SB, but the phase calibrator will
usually be observed with a relatively short cycle time of a few minutes. “Atmospheric” calibrations that enable
the system temperature to be measured are also regularly observed, but are not included in this table.

Various overheads are included in the time estimate and cover various software and hardware latencies e.g.
those caused by changing source/scan and starting and stopping an SB execution.

Figure 6.10: Example of the Time Estimate dialogue. A lot of information is shown! This is for a mosaic project
and the time per pointing has been calculated assuming antenna beam overlap. The ACA is also required and
its time has been estimated as a multiplication factor of the 12-m array time.

6.3.5.4 Additional time issues

The OT time estimates are sensitivity driven, but it is not always the case that the scientific goals require that a
particular sensitivity be achieved. For example, the time required for flux monitoring is usually based on getting
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enough samples of the source variability pattern, not that a particular sensitivity be achieved over this time. The
approved procedure in this case is to enter the sensitivity required per sample and then to select the “Does your
setup need more time...” button. This will indicate to the proposal assessors that the time stated by the OT is
not accurate and that a description and justification of the actual time required can be found in the attached
science and technical case. Note that this function should not be required to ask for additional time due to u, v

coverage issues, in contrast to the case at Cycle 0. With 32 antennas, it is expected that even the snapshot u, v

coverage will be able to produce sufficient image fidelity.

Similarly, flux monitoring often requires that multiple epochs be observed or that the observations be coor-
dinated with those at another observatory. In order to capture this information, the OT has a textbox as well as
a calendar tool for entering the dates. If this option is selected, it should also be fully justified in the attached
science case.

6.4 Summary Information

Once the proposal is complete, various pieces of summary information can be obtained. These come in three
varieties:

• Science Goal summaries – these consist of a single page and show a lot of technical detail. Right-clicking
on a Science Goal will provide access to its summary whilst the same on the Planned Observing node can
show all Science Goal summaries together.

• Proposal summary – this single page consists of information entered in the Proposal node (title, PI, abstract,
etc.) plus a very brief summary of the Science Goals.

• Technical Assessment Flag Sheet – this is intended to help the technical assessors by highlighting aspects
of the proposal that might need their attention. A good example is if only a single polarization has been
selected as this should very rarely be the case.

In addition to various combinations of the above, dependent on which node is currently selected, there are
also “Whole Proposal” summaries that combine the three types of summary and also include the Scientific and
Technical case. Right-clicking on a node will display what is available and allow either printable summaries to
be displayed or for a PDF version to be saved straight to disk.

6.5 Proposal Validation

Before submitting the proposal to the ALMA archive, it is highly recommended that the validation procedure
be run in order to make sure that the proposal contains no errors. In fact, it is even more highly recommended
to validate regularly during proposal creation so as to spot mistakes as soon as possible. After a successful
validation and, optionally, having saved the work locally, the proposal can be submitted. Even if validation is
not performed using the OT, it will be performed by the server in Chile. If this validation is not successful,
submission will fail.

6.6 Proposal Submission

Proposal submission is only possible from the File menu and can only be performed by the PI. Once the submission
is underway, a progress dialogue will be displayed and, depending on how big a proposal is, should lead to a
successful submission in a matter of seconds. Upon submission, an email will be sent to all investigators and the
PI will be asked to save the project to a local disk. Although it is possible to only work on the archive copy,
each submission overwrites the previous one. Therefore, maintaining local copies can be useful in the event that
reverting to a previous version becomes desirable. The OT will give a warning if submission of an older version
of a project is attempted, just in case this was not the intention.
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Once a proposal has been submitted, it will then be subjected to a scientific and technical assessment by
the ALMA Proposal Review Process. More details of this can be found in Chapter 7 of the ALMA Proposer’s
Guide.
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Chapter 7

Phase 2 Science Goals

As for creating a Phase 1 proposal, for non-interferometric experts the OT provides an easy way to create Phase 2
observing programs without needing to specify a large amount of observing detail. For standard observations,
the user can create observing projects by defining one or more Science Goals, each of which encompasses one task
the user may wish to perform. Within the Science Goal, the spatial, spectral and a number of control parameters
need to be defined, as well as some information needed for the calibration observations.

Creating a Phase 2 program via Science Goals is very similar to creating a Phase 1 proposal and is therefore
only briefly described here; more detailed information is in the previous Chapter 6. For experienced users the OT
also offers the possibility to define a Phase 2 program in much more detail by constructing Scheduling Blocks.
These details can be found in Chapter 8.

7.1 Basic Information

After having successfully applied for ALMA observing time, the user has to provide detailed technical information
on how the observations are to be executed at the observatory. Only after a successful submission of the Phase 2
information will a program actually be scheduled on the ALMA Array.

Depending on time allocation policies, the project information in the ALMA Archive may be different from
the Phase 1 proposal that the user originally sent to the observatory, e.g. a project may have been allocated less
time than was applied for or a project may have been split into a number of smaller projects.

Therefore, if you have (an) approved observing project(s), the project information needs to be retrieved from
the ALMA Archive and loaded into the OT. It may also be that the ALMA status (e.g. available configurations)
has changed since the Phase 1 submission. In that case, the information in the OT about ALMA needs to be
updated. For these reasons, it is always convenient and safer to start preparing your Phase 2 program with
up-to-date information concerning your observing project and the status of the ALMA Observatory.

7.1.1 Loading Project Information

You can retrieve the up-to-date information about your project(s) from the ALMA Archive via File → Open

Project → From ALMA Archive in the menu bar. This will start up the Project Finder dialog box, as displayed
in Figure 7.1, in which you can specify which project shall be retrieved from the ALMA Archive. Clearly, only
those projects can be retrieved for which the user indeed has access permissions. After the specifying the search
criteria a list of project will be displayed and the user can select. The retrieved project will become available to
the OT and you can start working on the Phase 2 specifications of your project.

Apart from retrieving the Phase 1 information from the Archive, Phase 1 and possibly (partially) completed
Phase 2 information can also be loaded from a local .aot file. To load a local file use the File → Open Project

→ From Disk. . . function from the menu bar.
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Figure 7.1: The Project Finder dialog box for selecting projects in the ALMA Archive.

To download the up-to-date project information from the Archive in the OT and for the actual submission
of Phase 2 programs to the Archive you will need a network connection; all work on a Phase 2 program can
be done off-line. This is very convenient in case you want to prepare your Phase 2 program on a laptop while
travelling, for instance.

Independently of how you retrieved the project: make sure that you download up-to-date and correct Phase 1

information before you take your computer off-line and start working on Phase 2.

7.2 Create Science Goals

To create a Science Goal, first select the upper project or theScience Plan node. Next, click on Edit → New

Science Goal (star with a “2”). This will create a Science Goal node in the Science Plan folder. It consists of five
forms: General, Field Setup, Spectral Setup, Calibration Setup and Control and Performance Parameters, all
identical to the Science Goal fields that have been discussed in Chapter 6 on Phase 1 proposal preparation.

The subsequent steps for filling the the Science Goals are identical to those described in the previous chapter
for Phase 1.

7.2.1 Science Goal Visual Editors

As with the preparation of the Phase 1 proposal, the Visual Spatial Editor can also be used to specify the field
parameters for the Phase 2 Science Goal. For a description of the Spatial and Spectral Editors, please read
Chapters 9 and 10.

7.3 Generate Scheduling Blocks

As for Phase 1 Science Goals it is possible to generate SBs from the Phase 2 Science Goals: Choose Tool

→ Generate Phase 2 SBs from all the Selected Goal, or use the button Generate SBs from the Selected
Science Goal in the menu. In the Phase 2 Science Goal the OT will create an ObsUnitSet "xxxx - SI" where
xxxx is the source name. The ObsUnitSet contains the SBs generated from the Science Goal. SB generation
can also be initiated from the right-click pop-up menu, or by pressing the appropriate button on the toolbar. If
the ObsUnitSet and the SBs already exist from a previous mapping, a dialogue box is displayed to check that
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overwriting of the previously-generated ObsUnitSet is really desired.

The current version the generation algorithm supports the generation of SB(s) for a single pointing and a
rectangular mapping area. This rectangular mapping area is converted to a multi-field (pointed) mosaic standard
interferometry SB. A single Spectral Setup and Control Parameters is also allowed. For a Science Goal containing
multiple sources, an error/warning message is displayed and SBs for the first source only will be generated.

To see the result of the mapping, you can open the ObsUnitSet node in the Science Goal. From this point you
can manually adjust the SBs. However, again, building and editing SBs requires some experience and in-depth
knowledge of how ALMA works. For further information on how to construct and edit Scheduling Blocks for
Phase 2, consult Chapter 8.

The OT also manages the link between a Science Goal and its ObsUnitSet. For example:

• If a Science Goal has an associated set of SBs, deleting the Science Goal will also delete its ObsUnitSet. A
dialogue box appears asking for confirmation to delete.

• Attempting to delete a generated ObsUnitSet, partially or fully, will result in a warning.

7.3.1 Scheduling Block Restrictions

Presently, SBs generated for Science Goals contain only one source. The number of SBs that are created for a
Science Goal depends on its parameters, mainly the angular resolution and largest angular scale. The algorithm
used to split the project into SBs is described below.

The current version of the Scheduling Block generator does not support sideband separation of DSB receivers,
i.e. using both sidebands, LSB and USB, at a time. The Multi Resolution Mode of the 64-input correlator is
used to configure more than 1 spectral window in a baseband, each. with potentially a different bandwidth
and number of channels. The Multi Region Mode is similar, but every spectral window must have the same
bandwidth and number of channels.

7.3.2 Algorithm Used for Splitting SBs

The algorithm used to split the requested observation into one ore more SBs considers two requirements: the need
to cover the desired range of angular scales, and the need to ensure full uv-coverage. The ALMA configurations
are designed so that in most cases good uv-coverage is obtained in one go. They generally also provide a wide
range of baselines, meaning only a few configurations are needed to cover most angular ranges desired.

The angular scale range which an array configuration covers is determined by the ratio of the maximum and
minimum baselines of the configuration. Values of this ratio, N , are different among each array configurations;
the value N = 50 is used as a representative value at present.

Let SARG = Smallest Angular Resolution Goal and LARG = Largest Angular Resolution Goal. If N ∗
SARG < LARG, then it is impossible to cover the angular range by a single array configuration. In such a case,
the observation is split into more than one SB. The ideal split would be an SB with a desired resolution goal of
SARG, then one with a goal of N*SARG, and so on.

However, in reality there are other considerations. Here we bring in the following two conditions:

1. We aim for SBs with angular resolution ranges that overlap by 10%. This makes the split SARG, (1-
0.1)*N*SARG, and so on.

2. For scheduling we allow a 50% margin which specifies the range of acceptable angular resolutions. This
makes the split (0.8*SARG, 1.2*SARG), (36*SARGS, 54*SARGS), and so on.

In terms of hour angle, splitting is only performed when the elevation of the target is low and the resolution
required is sufficiently high that one of the "Y" configurations is needed; this combination will not give good uv-
coverage. The threshold for elevation is 35 degrees and that for resolution is 0.1 arcsec; consequently observations
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for which the desired resolution is less than 0.1 arcsec and the elevation lower than 35 degrees are split into two
SBs with 0, 12 and 12, 24 as the minimum and maximum allowed hour angles.

7.4 Phase 2 Validation and Submission

Before submitting the proposal to the ALMA Archive, the validation procedure should be run to make sure
that the Phase 2 program is technically in a healthy state and consistent with the observatory’s policies. As for
Phase 1, validation is performed on the Scheduling Blocks, specifically those that are created from the Phase 2
program.

After a successful final validation and having saved the work locally, you are now ready to submit your
Phase 2 program to the observatory. The submission process to the ALMA Archive is described in Section 3.6.
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Chapter 8

Phase 2 Scheduling Blocks

As already mentioned in Chapter 7, Scheduling Blocks provide the user more control over the telescope configu-
ration and observing strategies. With SBs the details can be specified how the instrument will be setup for the
execution of a scientific project.

This chapter shows how a Phase 2 program can be built or adjusted by Scheduling Blocks and explains how
the spatial and spectral specifications can be set. Note that this chapter is meant for experienced users mainly.

Spatial and spectral specifications can also be provided via the OT Visual Editors. In the following Chapters 9
and 10 the Visual Spatial and Spectral Editors will be discussed.

8.1 Starting Up

To work on the Phase 2 program, in the Project Structure pane select the Phase 2 tab. In the Editors pane
select the Forms tab that carried the name of the program. Using this tab the forms that need to be filled in will
be displayed. The Spatial and Spectral tabs can be used to display and enter information via the Visual Spatial
and Spectral Editors (see Chapter 9 and Chapter 10).

While creating your Phase 2 program and entering data in the forms, a validation procedure checks that the
input is indeed legal, i.e. that is has the right format and is within the allowed boundaries.

8.2 Phase 2 Observing Programme Structure

Having started the OT to work on a Phase 2 program, and after having download the Phase 1 Science Goals
from the ALMA Archive, the Projects Structure pane will contain the Science Plan node with the Science Goals.
Clicking on the Science Plan folder provides a help message that gives the user basic instructions for creating
an observing program. When clicking on the Project node in the Project Structure tree, the Project form will
appear in the Editors pane and can be filled in.

As described in Section 7.3 Phase 2 SBs can be created from the selection Science Goals using the Generate
SBs from the selected Science Goal button the menu. These SBs will be grouped in the ObsUnitSets in
the Science Goal node. In additional to these generated ObsUnitSets, ObsUnitSets can also be generated in the
program tree.

8.2.1 The Observing Unit Set

The ObsUnitSets are nodes that can contain either other ObsUnitSets or one or more SBs. To create an
ObsUnitSet, select the Science Plan folder and choose Add ObsUnitSet either with a right click or from the Edit
menu (AddObsUnitSet). A Special Observing Program folder is created that contains a new empty ObsUnitSet.
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Note that the Special Observing Programme is also used/created and populated with Scheduling Blocks when
these are generated from a Phase 1 proposal.

Figure 8.1: The form for the ObsUnitSet. The basic project structure tree is displayed at the left in the Project
Structure pane.

By clicking on the ObsUnitSet node in the Project Structure pane the ObsUnitSet form will appear in the
Editors pane. It is displayed in Figure 8.1 and consists of five panels with fields for entering the following
parameters. Note that currently only the first two (Basics and Control) are in use.

• Basics contains the name, the status of the ObsUnitSet, as well a description;

• Control contains basic control parameters and required accuracies for the ObsUnitSet;

• Unit Dependencies specifies the dependencies between the ObsUnitSets and contains fields for controlling
the execution of the ObsUnitSet;

• ObsUnitSet specifies the scripts for data processing and for controlling the execution of the ObsUnitSet;

• Data Processing defines the desired specifications for the output data after processing the complete Ob-
sUnitSet.

Also, by selecting the ObsUnitSet node in the project structure tree, a couple of menu items under the Edit

button in the menu and in the toolbar will be enabled/disabled. You may also right-click on the ObsUnitSet in the
Project Structure tree to get the drop-down menu. Within the selected ObsUnitSet you have the choice between
creating another ObsUnitSet or a SB; a new SB will be located in the selected ObsUnitSet node. Similarly,
when selecting an ObsUnitSet, this set will be located within the selected ObsUnitSet. By creating multiple
ObsUnitSets, each with one or more SBs, you have the possibility to create a more complex Phase 2 observing
program. Note that an ObsUnitSet can either contain one or more ObsUnitSets or one or more SBs. It cannot
contain a mixture of these.
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An ObsUnitSet, either attached to a Science Goal or separately created, can be protected from editing; this
feature is mainly focused on novice users. The default is that it is turned off, but it can enabled by the optional
setting: Menu → Options → Advanced → Enable OUS protect.

Figure 8.2: The lower part of the Scheduling Block form.

8.2.2 The Scheduling Block

Let’s assume the ObsUnitSet now contains a newly-created SB. In the Project Structure pane the SB(s) is (are)
visible directly below the ObsUnitSet. Each SB contains a Target folder with one or more Targets and the folder
Resources, that contains detailed information about the science and calibration Targets, the instrumental setup
and the observing parameters. The Resources folder initially contains 3 empty folder: Field Sources, Instrument

Setup and Observing Parameters.

When clicking on the Scheduling Block node in the Project tree, the SB form will appear in the Editors pane.
It consists of seven panels with input fields. The first three panels, Basics, Control and Unit Dependencies are
all very similar to the panels in the ObsUnitSet form (except that the panels and their fields now apply to this
SB). In case of apparent clashes the SB values will take precedence. The second half of the SB form is displayed
in Figure 8.2.

The last six panels in the SB form are:

• Preconditions which specifies the minimal observing conditions for the execution of this SB.

• SchedBlock which specifies details about how the Scheduling Block is to be executed: maximum time,
number of repeats and the executable observing script.
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• Advanced Parameters which is only available for expert use and is described in more detail in Appendix D.

• Performance Goals and Scheduling Constraints which specifies the Science Goals for the observations after
data calibration; The panel contains fields for the Representative Target, Coordinates, Frequency, and
Receiver Band. These fields should be filled in case the SB contains more than one Target and/or more
frequency settings (see below) and will normally be completed when a representative target is selected for
the SB , either via the SB form in the Editors pane or as a result of SB generation).

• Temporal Constraints where any time constraints for the SB can be defined. The editor support zero to
many constraints, each of them having its own tab. The SB will be rescheduled by the dynamic scheduler
for each of the Temporal Constraints added. The editor supports adding new constraints, deleting the
selected constraint, and deleting all. The

• Observing Groups which displays a table with the Observing Groups in the SB. For further details see
Section 8.3.3.

The SchedBlock panel of the SB form contains a number of fields for describing the observing mode. The
most relevant items in the panel are:

• Standard Mode: A Boolean, should be true for indicating a standard mode. For Expert modes the value
should be false and not checked.

• Mode Name: a drop-down list offering the currently available modes: Tower Holography, Astronomical
Holography, Optical Pointing, Offset Optical Pointing, AIV Single Dish, Calibrator Survey,
Standard Interferometry and Expert Mode.

• Mode Type: Observatory (an observatory mode, e.g. calibration), User (science observing) or Expert.

• Execution Count: The number of times this SB shall be repeated.

• Indefinite Repeat: Click this box in case this SB shall be repeated indefinitely.

• Obs. Procedure: This file contains the name of the observing script and will be set when filling out Mode
Name; it may also be edited by hand.

• Run Quick Look: This parameter controls whether or not Quick Look is initiated for this SB. At the
moment this needs to be set by the user (default is true). Later, sensible defaults will be applied depending
on the observing mode.

When the SB is generated from the Science Goal (see previous chapter) this information is inserted auto-
matically. However it may be overridden. When the Mode Name and Mode Type are set manually the Standard
Mode field should be selected. This will set all of the other relevant information. Eventually, only authorised
observers will be allowed to change the Mode Type, Standard Mode fields and the script.

More SBs can be created when selecting the ObsUnitSet with Edit → Add Scheduling Block. If you are not
happy with your SB you can delete it easily: Click on Edit → Delete. The right mouse button can also be used.

8.2.3 Targets and Resources

As mentioned above, when creating a Scheduling Block, the Target and Resources folder are initially empty. For
a valid Phase 2 program, at least one SB containing at least one Target (science, calibration, optical pointing)
should be specified. Below follow details about the concept of Targets and how these are created. Providing
content to the Targets and Resources folders is described in the next section.
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8.2.3.1 Targets

A Target essentially defines an observation of a given source that will take place in the timescale of one SB. Its
definition is close to the idea of a scan. Targets are stored in the Target folder which is the first visible when
expanding the SB in the project structure.

The complete observing details of a target are described in the Target form. The form consists of three panels
Field Source, Instrumental Setup and Observing Parameters. The fields in these panels are defined by filling out
the forms in the corresponding folder in the SB Resources folder and attaching these forms to the Target. To be
valid, a Target must have at least one attached Field Source, Instrument Setup and Observing Parameters.

Figure 8.3: An example of the Target and Resources folder in a Scheduling Block.

Working with attachments allows constituent parts of a Target to be re-used, e.g. the same Spectral Setup
may be used in two different Targets, without copying or entering the information twice. Attachments also
provide the ability to specify the scientific intent of a Target and to allow multiple intents for any given Target.
For example, a science Target may also act as a calibration observation (phase, amplitude, etc.).

Normally, a science Target has one parameter set attached to each of the Field Source, Instrument Setup and
Observing Parameters folders. In the case that a SB contains more than one target, it is necessary to select one
of these to be used as the Representative target for that SB. This Representative Target is then used to
monitor performance goals.

To set a Representative Target, select it in the Target folder in the Project Structure tree and use a right
mouse click to get the pop-up menu. Select Set As Representative Target. This selection will then fill the
field Representative Target in the SB form. Clearly, only one Target may be selected per SB. Representative
Target can be left empty if the SB contains only one Target.
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8.2.3.2 Resources: Field Sources

FieldSource forms are contained with the Field Sources folder. Each form defines the details of the source
to be observed e.g. source name and positions, source properties and field pattern that shall be used for the
observations. The latter may be a single point (possibly offset from the source position), multiple points, or
some sort of OTF scan pattern. Presently, rectangular OTF patterns, a list of single points and a cross field
pattern are supported.

Note that for observing objects in the in the solar system an JPL HORIZONS ephemeris can be uploaded.
Details in the Section 6.3.

Only one FieldSource may be attached to a Target.

The Field Source setup in the Schedblock also allows the user to define the source or sources to be used in
the form of a query instead of a specific source. To select this Virtual Targets option check the box at the
top of the editor that says Select target from ALMA calibrator catalogue at execution time. In the
Target form in the Editors pane Field Source panel will replace with the Calibrator Search Parameters panel
that provide the various query fields. The panel is identical to the Calibrator Search Parameters panel in the
Calibrator Selection Tool. For details see Section 5.4 and Figure 5.4.

The query is constructed from a cone search over a given radius around a central RA/Dec (J2000) position,
plus min/max frequency, min/max flux limits, and a time window since the calibrators were last observed. This
query is stored in the SB, and at execution time Control will execute the query to retrieve sources matching it
that will be observed. There is also a Maximum number of sources field which instructs control to observe up
to this number of the results returned. Note that since only the ALMA Calibrator catalogue is searched the uses
of this virtual target option are limited, but it is expected to find major use in Observatory Calibration modes.

8.2.3.3 Resources: Instrument Setup

This folder contains the Instrument Setup form that defines the instrumental setup of the observations e.g. the
spectral specification, the frequency setup and the details for the correlator configuration. Most users will wish
to specify a spectral and correlator setup, but an optical camera setup is also allowed. The latter is used in the
optical pointing calibration mode. A spectral setup basically consists of a receiver and correlator setup.

Only one Instrument Setup may be attached to a Target.

8.2.3.4 Resources: Observing Parameters

This folder contains the intent for a target observation and specifies observing parameters, like integration time,
and sensitivity goals. A different name (parameters) was chosen to avoid confusion with the slightly different
use of the word intent in the offline subsystem. There is currently one form for science parameters, many forms
to specify the parameters for the various possible calibrations, and forms for optical pointing and holography
parameters.

To add observing parameters, first select the folder Observing Parameters in the Resources folder of a scheduling
block. Next select the type of observing parameter from the list from the Edit menu or via the right mouse
button. It is possible to attach more than one Observing Parameters form to any given target. Hence, there can
be multiple intentions for a specific target.

8.3 Targets

After having created a scheduling block, the Targets and Resources folders can be populated. This can be done
in any arbitrary order. First create one or more empty targets and create and fill the Field Source,Instrument
Setup and Observing Parameters forms. Alternatively, one can first specify field sources, instrument setups and
observing parameters (again in any arbitrary order) and then create a target in the Target folder. What is crucial
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though is that a target is only valid when it has an attached Field Source, an Instrument Setup and one or more
attached Observing Parameters forms.

Normally, for science observations, the Target folder is populated with at least one observing (science) target
and one more calibration targets. In addition to the science and calibration Targets, SBs can also contain targets
for optical pointing and for holography.

Figure 8.4: A Project Structure that contains one SB. The Target folder contains one science target and many
calibration targets. In the Target folder the phase calibration target is selected and its attached forms are
highlighted.

8.3.1 Add a Science Target

To add a science Target, first select the SB to which it shall belong or the Target folder. Then from the menu
select Edit → Add Target. Alternatively, the right mouse button can be used after first selecting the SB or the
Target folder. The Target will be added to the Target folder under the SB in the Project Structure tree.

When clicking on the newly-created Target, the Editors pane will display three empty panels i.e. No Field

Source, No Instrument Spec and No Observing Parameters. To have a valid Target, a Field Source, Instrument
Setup and one or more Observing Parameters must be created and attached. When versions of these exist they
can be used and attached to the newly created Target. The Target form in the Editors pane will provide an
overview of which of these is available.

To create a new Field Source, Instrument Setup and Observing Parameters, you can use the Create new
option. After creation, the Field Source, Instrument Setup, and Observing Parameters are automatically attached
to the Target. The corresponding panel will then be loaded with empty fields and parameters can be provided.
When specifying the observing parameters, the purpose of the Target needs to ticked first. After all parameters
in the forms have been entered, they are automatically attached to the Target.

More details about entering resources details are given in Section 8.4.
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8.3.2 Add a Calibration Target

Similarly to adding a science Target, a calibration Target can be added to the Target folder via the menu or
by using the right mouse button. Also, creating and attaching a Field Source and Instrument Setup is similar
to what has been described in the previous section. The choice of the Observing Parameters will depend on
the type of calibration. In the OT, the following calibration types can be specified: phase, pointing, amplitude,
polarisation, focus, atmosphere, delay and bandpass.

Different calibration types may use the same calibrator source. Thus, calibration targets in the Target folder
may share the same FieldSource, but have different Instrument Setup and Observing Parameters. Similarly,
different calibration Targets may have the same Instrument Setup attached.

To add calibration Targets to an SB that already contains one or more science Targets, the Calibration
Selection Tool can be useful. First select a science Target and then in the OT Menu select Tools → ALMA

Calibration Selection Tool. If the position of the science Target has been specified (in an attached FieldSource)
the Calibrator Selection Tool GUI will display the RA and Dec coordinates. Otherwise, the coordinate fields will
be zero and the user has to provide these. Next, the maximum distance to the science Target shall be defined.
Also, the fields for Frequency and Flux density specification can be filled. With the Calibrator Tag field
the user can optimise the search for a particular calibrator type. Use the Submit Query button to select all
calibration sources that fulfil the specifications. From this list of calibrators, select one by clicking in the table.

After having selected the calibrator, the Select As . . . button provides you with a dialogue box. The dialogue
box consist of two parts. With Calibrator type one can specify for which calibrations the selected calibrator
is to be used (amplitude, phase, etc.). On the right the user can specify which Instrument Setup should be
attached to the calibration Target.

For the selected calibrator, the Calibration Tool will add one Target to the Target folder and attach a
FieldSource and an Observing Parameters set. On the right in the dialog box, Copy to new setup will create a
copy of the science Target’s Instrument Setup and attach this to the calibration Target. Link to same setup
will attach the science Instrument Setup to the calibration Target. Do nothing will not create an Instrument
Setup for the calibration target. Note that an Instrument Setup can only be copied or created when it exists.
To create an Instrument Setup please refer to the next section.

Figure 8.5: Overview of the Targets in the Target folder in the project tree. The table is displayed when clicking
on the folder.

An example of a calibration setup created by the Calibration Tool is displayed in Figure 8.4. In the Project
tree, one science Target has been defined (HD163296). In the Calibration Tool, J1820-254 was selected for
doing phase calibrations. NRAO530 is used for pointing, focus, bandpass and amplitude calibration. For the
case of the bandpass calibration, the Copy to new option was selected to replicate the Instrument Setup of the
science Target and attach it the bandpass calibration target. In the Observing Parameters folder, parameter sets
are created for the different calibration targets. By selecting the calibration target, all forms attached to the
calibration target are highlighted. Vice versa, when selecting a Observing Parameters form, all targets using
that form will be highlighted.

When clicking on the Target folder, the Editor pane shows a table with a summary of the current Targets. For
an example, see Figure 8.5. Similar tables can be displayed for the Instrument Setup and Observing Parameters

folders.

8.3.3 Observing Groups

The user has the ability to create an Observing Group for targets where they can be organised into an ordered
list. Under the Scheduling Block node in the Phase 2 program tree, the user has the option to Add Observing
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Groups from the Edit menu or by right clicking on the node and choosing the option from the context menu. A
new Observing Group folder will appear in the project tree. Clicking on the folder displays the Observing Group
form in the Editors pane.

Figure 8.6: The Observing Group panel in the Editors pane for handing an Observing Group. On the left are all
available Targets. The table on the right lists the Targets in the Observing Group.

At the top of the form the user can enter a name for the Observing Group. The default name for newly
created Observing Group folder is Observing Group N where N is a sequential creation number for that group. The
user can also change the name of the Observing Group by right clicking on the folder in the project tree and
selecting the Rename menu option from the context menu.

The Observing Group panel has two tables. The table on the left includes all of the Targets that have been
created by the user as part of the parent SB. The table on the right shows the Targets that make up the Observing
Group. The user can select Targets from the All Available Targets table and click on the right arrow button to
add it to the Observing Group. Targets in the Observing Group Targets table can be deleted or moved up/down
using the button below the table.

The ordering of the Observing Groups in SB and their names can be edited here. The user can click on
the name columns and edit the observing groups name. Below the table are buttons for manipulating selected
observing group rows in the table. These buttons carry out actions for deleting and moving the rows.

Note that Observing Groups cannot be dragged and dropped in the project tree as this caused unexpected
behaviour that could be interpreted as a bug.

8.4 Resources

The previous section shows how new targets with (still empty) Field Source, Instrument Setup and Observing

Parameters folders are added to the SBs. Specifying the Resources for the Targets can be done in two ways:

1. Filling out the forms that become visible in the Forms tab of the Editors pane when selecting them in the
Field Source, Instrument Setup and Observing Parameters folders.

2. Using the Visual Editors in the Editor pane. The Spatial tab in the Editors pane gives the Visual Spatial
Editor. Using this editor you can specify the Field Source parameters, including the observing field speci-
fications and the source properties.
The Visual Spectral Editor is available via the Spectral tab and can be used to specify the Instrumental
Setup, e.g. the receiver setup, the position of the lower and upper sidebands and correlator configura-
tions, as well as the frequency specifications for the basebands. The Visual Spectral Editor also offers the
possibility of optimising the receiver frequency settings.

This section deals with entering the Observing Parameters using the Forms editor. After having completed
the Resources forms, Section 8.5 shows how to attach these to a Target.
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8.4.1 Field Sources

To define the Field Source parameters, select on the Field Source folder in Resources. Via Edit → Add Field

Source you can now add a blank Field Source node to the Field Source folder. Alternatively, you can right click
and select Add Field Source from the pop-up menu. Then, when selecting the newly created Field Source the
empty Field Source form is displayed in the Editors pane.

In the Field Source form the source properties should be provided. At the top of the form, using the Name
field the name of this parameter set can be specified. Next, you can enter the object name in the Source Name
field. Clicking on the Resolve button may resolve subsequent source parameters in the form automatically (e.g.
the coordinates). A window will display the server name that returned the query results. A tick box is available
for solar system objects with non-sidereal motions. Known flux information of the source can be added into a
table.

Figure 8.7: The upper part of the Field Source form with the Fields Source and Reference Positions panels.
Because the Use Reference box is tagged, the fields in the Reference Position section are made visible.

In the case of single dish observations with on/off source integrations, the user should tick the Use Reference
box. This will expand the Reference Position panel, where the reference position and the on and off integration
times should be given. A second reference tab can be added and deleted using the Add and Delete buttons. For
interferometric observations the Use Reference box should remain unchecked.

The Field Pattern panel can be used to define the area to be mapped and contains a drop-down menu for
specifying the actual pointing pattern of the observation, with the source coordinates as the origin of the pattern.
When selecting a pointing pattern the parameters should be provided in the panel below the Field Pattern panel.
An example of this panel in the case of the rectangular pointing pattern is given in Figure 8.8.

Currently, the pointing types point, rectangle and cross are supported. Others will follow. In the case of
single pointing, one can specify the pointing in absolute coordinates or relative to the source position. Hence,
this structure allows you to point in a specific region of your target. Note that the single pointing type allows
one to add more pointings. This is to support arbitrary pointing patterns in case the user does not want to select
the standard pointing field patterns provided.
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Figure 8.8: The lower part of the Field Source form with the FieldPatternEditor and field pattern properties
(rectangle) panels.

After having created one or more Field Sources and having filled out the forms, clicking on the Field Sources

folder shows a table of the available Field Sources in the Editors pane.

8.4.2 About Basebands, SideBands and Spectral Windows

8.4.2.1 Upper and Lower Sideband and Basebands

The positions of the upper and lower sidebands (USB and LSB) within the ALMA Receiver Bands are determined
by the choice of the first Local Oscillator (LO1) setting. The bandwidth of each sidebands is 4 GHz for 2SB
receivers (bands 3–8) and 8 GHz for SSB (bands 1 and 2) and DSB (bands 9 and 10) receivers. The central
frequencies of the sidebands are separated from the LO1 frequency by this bandwidth. In order to fully use both
sidebands, the value of LO1 must be separated from the edge of the ALMA receiver band by this bandwidth
×1.5.

For each science or calibration Target, the user can specify up to four basebands. Hence, within the selected
ALMA receiver band it is possible to observe in four basebands simultaneously. The central frequency of each of
these basebands is determined by LO1 and the frequency setting of a second local oscillator (LO2). All basebands
can be placed in either the LSB or the USB or two can be in each sideband. Since the system provides only
limited choices for the LO2 frequencies, obtaining the requested central baseband frequency for each baseband
requires the right combination of LO1 and LO2.

8.4.2.2 Spectral Windows

The bandwidth of a baseband is fixed at 2 GHz, but data is only taken within one or more spectral windows.These
are defined using the Tunable Filter Bank (TFB), a piece of hardware that allows up to 32 spectral windows to
be placed within each baseband. Each spectral window is built up from filters that have a bandwidth of 31.25
or 62.5 kHz, the smaller value only being available when Twice Nyquist sampling i.e. oversampling, is utilised.
In this way, one or more spectral windows with a variety of bandwidths can be placed independently in each
baseband. The rules for doing so are complicated, but the OT tries to guide you through the restrictions. Up
to 8192 spectral channels can be placed across the spectral windows in each baseband, depending on various
things, but including the number of polarisation products that are being calculated. This number also depends
on the number of correlation bits and on whether the data are being oversampled. The maximum bandwidth
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of a spectral window cannot be greater than the baseband bandwidth and the choices for the resolution are
restricted. The ALMA correlator is therefore extremely flexible and can be configured in a large number of ways.
For example, a 1 GHz wide spectral window with 4096 channels can be combined with one with a 125 MHz
bandwidth, also with 4096 channels, but delivering much higher spectral resolution. The central frequency of
each can be set independently.

In order to determine the continuum level in a spectral window, a maximum of ten spectral average regions
can be specified. For each of these spectral average regions, a start channel number and the number of channels
over which the average is to be calculated should be specified.

The spectral specification is defined in the Instrument Setup form in the Instrument Setup folder in the
Resources folder of the SBs. Below, an overview of the various panels in the Instrument Setup is given.

8.4.3 Instrument Setup

In order to successfully specify the various parameters for the frequency, baseband and correlator settings, this
section gives an overview of the possible choices and their mutual dependencies. Note that not all input fields of
the Instrument Setup form are discussed. A complete list of all Instrument Setup parameters and their detailed
descriptions is provided in the ALMA OT Reference Manual.

8.4.3.1 Three choices for the Instrument Setup

With ALMA, a signal can be detected using one of two correlators or with the square-law detector. For a corre-
lator setup one can choose between the 64-input correlator and the Atacama Compact Array (ACA) correlator.
Note however, that within a single SB only one type of correlator can be selected. Hence, once a setup with one
type of correlator is added, you are prevented from choosing the other type when adding to that SB.

In the Instrument Setup form, the parameters needed to define a spectral specification and the correlator or
the square law detector setup should be filled in. To create the Instrument Setup form select the Instrumental

Setup folder in the Resources folder. Via Edit → Add Spectral Spec with BL Corr Config, Edit → Add Spectral

Spec with ACA or Edit → Add Spectral Spec with Square law detector you can add one of the two correlator
configurations or the square law detector. Alternatively, you can right click and select Add ... from the pop-up
menu.

If you wish to use square law detectors together with the 64-input or ACA correlators, i.e. to set up a hybrid
mode observation, add a spectral spec with BL correlator configurations (or ACA) and then check the Total
power with square law detectors check box in the Spectral Spec panel in the Spectral Spec form editor.

When selecting the newly-created Instrument Setup, the empty spectral specification form is displayed in the
Editors pane. First, select either the Forms or the Spectral tab of the Editor pane and make sure to extend the
Editors pane or to scroll so that the Spectral Spec and either Correlator Configuration or Square law Setup panels
of the Instrument Setup form are completely visible as displayed in Figure 8.9. If the Spectral tab is selected,
the Visual Spectral Editor is enabled (see Chapter 10).

8.4.3.2 Spectral Specifications

At the top of the form, the name of the Spectral Spec set can be entered, followed by the rest frequency of the
line and its transition (e.g. for a known molecular line). The button Line Catalogue can be used to launch the
Spectral Line Selection Tool. A detailed description of the tool can be found in Section 5.3.

If you select the line from the catalogue list the fields are filled in automatically. The Receiver Band field
is defaulted to the correct value. Alternatively, you can specify the Transition and Rest Frequency fields
manually. Also, even with manual input, the Receiver Band will be defaulted based on the frequency.
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Figure 8.9: The panels and fields for the Spectral Spec, Switching and Correlation Configuration. A similar
layout exists for the the square-law detector.

8.4.3.3 Switching

Below the SpectralSpec panel is the Switching panel. The default setting for switching type is NO_SWITCHING
and the fields for other parameters Dwell Time and Dead Time in this panel are disabled. Those fields will
be enabled by selecting one of the switching types other than NO_SWITCHING or FREQUENCY_SWITCHING. If you
choose FREQUENCY_SWITCHING, you can set up switching configuration at the Switching panel in the Baseband
configuration editor below.

8.4.3.4 Square Law Setup

This panel is only visible when the Square Law Detectors option is selected, either in the Square Law Detector
Instrument Setup form (created with the Add Spectral Spec with Square Law Detector option) or when the
Add Total power with square law detectors... box is checked in the 64-input or ACA Instrument Setup
form. Note that in the latter hybrid case, the same basebands are used for the correlator and square law detector.

8.4.3.5 Correlator Configuration

This panel is only visible on the 64-input and ACA Instrument Setup form, i.e. when the Baseline correlator or
the Atacama Compact Array correlator has been chosen.

The 64-input correlator configuration validator has four options for 64-input correlator restrictions: 4 quad-
rants, 2 quadrants, 1 quadrant and 2 antennas. The default is 4 quadrant i.e. the full ALMA correlator. You can
change this in Select BL Correlator Type section of the Preferences → Telescope menu. As the choice is saved
in the user preference file, you don’t need to do so every time. The 2-antenna option was mainly used for the
ALMA Test Facility two-antenna interferometer and is unlikely to be needed.

In the panel Correlator Configuration, the fields Integration Duration and Channel Average Duration
are visible. Integration Duration determines the number of Dump Durations that can be specified in the
special field (16 ms for cross correlations, and 1, 2, 4, 8, or 16 ms for auto-correlations) to be executed before
sending data off for the spectral windows to be accumulated. The Integration Duration will be longer than
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the Channel Average Duration (see below) and is often a multiple of it, but it doesn’t need to be. Further the
Atmospheric Phase Correction Data To Save option can be chosen. To help the user to get these numbers
right, the ADJUST buttons can be used.

Also visible in the Correlator Configuration panel are the drop-down lists to select thr Correlator Accumula-
tion and Local Oscillator modes and the check boxes to select the 90 or 180 degrees Walsh function to be applied.
Please check the Reference Manual for further details.

Below the Correlator Configuration panel, the BaseBand Configurations specifications can be filled in. The
following paragraph describes how this is done.

8.4.3.6 BaseBand Configurations

In the panel BaseBand Configurations up to four baseband configurations can be defined. An overview of the
upper part of this panel is provided in Figure 8.10. A number of fields for specifying the basebands and their
spectral windows are described below. More details can obtained in the OT Reference Manual.

This panel contains a summary table of the baseband configurations; it lists the name, centre rest frequency,
data products and sideband separation, the LO2 frequency and the data rate for each of the basebands. Just
above this is the LO Setup Preferences panel that can be used to calculate the LO frequencies. Depending
on how many baseband configurations have been defined, the LO Setup Preferences subpanel can be used for
optimising the position of the frequency band by adjusting the LO1 and LO2 settings. In the Sideband(s) to
prioritise check boxes the user can indicate the priority for the USB and LSB. Below there are check boxes
for each of the base bands in which the user can enter a weight between 0 and 100 to priorities these base bands
for calculating the LO1 frequency. Pressing the Calculate LOs button will calculate the LO setup according to
the entered parameters.

The best setup, in terms of LO1 (and LO2) settings for a single or multiple baseband configuration is
determined by calculating the error between the ideal and the adjusted LO2 settings for each of the basebands and
minimising the sum of these errors. After clicking on the Calculate LOs button, a summary of the optimisation
results can be seen in the pane, using the Information tab. Clicking on the expansion symbol >> will provide
you with the details, including the ideal setting of the LO1 and LO2 frequencies, the frequency offsets given
the system limitations in setting the LO2 frequencies and the adjusted LO1 and LO2 frequencies. After the
optimisation is done, the results are visible in the LO1 Frequency fields. Also visible is the expected total data
rate.

LO Configuration is also supported by the LO Configuration Tool via Tools → ALMA LO Configuration

Tool. This is an experimental tool that runs on a separate window and is also intended for expert users. It
implements the same algorithm which will be used in the Control subsystem that will set the LO settings during
the actual observations. For details see Section 5.5.

In the BaseBand Configurations panel there is also an advanced Engineering sub panel. The user must click
on the Engineering Set-up button to enable this sub panel. After doing so the user can enter values for the
FLOOG, enable/disable Tune High and the LO1 Frequency value directly. Enabling the engineering set-up also
has the effect of making the Centre Freq (Rest) column read-only and the LO2 Frequency writable in the base
band table.

8.4.3.7 Baseband Specifications

Below the baseband summary table and the LO Setup Preferences panels are tabs containing the details of each
of the basebands. Initially, no baseband configuration is available and at least one baseband configuration should
be defined. To create a baseband configuration, hit the Add BaseBand button. The first baseband (with index
1) will become visible. Most fields will be zero or have default values.

As already mentioned, some of these parameters depend on previous settings, e.g. on the receiver bands and
on other settings in the upper panels of the form.

In the Products & Sideband Separation field you can specify the combination of correlation products and
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Figure 8.10: The fields for defining the baseband Configurations.

the sideband separation mode. Only allowed combinations are listed, this depending on the receiver type and
the choice of Accumulation Mode. When ALMA_FAST is selected for the accumulation mode, AUTO_ONLY & NONE
is the only choice. Otherwise, i.e. when ALMA_NORMAL is selected, one or more choices are listed depending on
the receiver type. FREQUENCY_OFFSET_REJECTION is the only allowed choice if the receiver type is SSB (Band 1
and 2) or 2SB (Band 3-8). Note that PHASE_SWITCHING_REJECTION is not listed: it is not supposed to be used
although ALMA has the function. For the DSB (Band 9 and 10) receiver type, the modes of separation are
PHASE_SWITCHING_SEPARATION and FREQUENCY_OFFSET_SEPARATION as well as FREQUENCY_OFFSET_REJECTION.
The option FREQUENCY_OFFSET_SEPARATION is not available for the ACA correlator.

8.4.3.8 Spectral Windows

After a configuration is created for each of the basebands, one or more spectral windows need to be specified. At
the moment, up to 32 spectral windows are supported. Each of these windows will correspond to a contiguous
spectral region within the baseband bandpass. The bandwidth of a spectral window can range from 31.25 MHz
to 2 GHz and they can be observed at a spectral resolution that also depends on the number of spectral windows
that are being used and their specifications. A maximum of 8192 channels per baseband is allowed, depending
on the polarisation mode. The validator will actually check if specifications do not exceed the available resources
of the correlator.

For each of the baseband configurations the details of the spectral windows are included in the Baseband tab
in the Spectral Windows panel. At the top a summary table provides an overview of the spectral windows that
are defined for the baseband. Some of the spectral window parameters can be specified in the table by clicking
in the table cells. Below the overview table, for each spectral window the full set of parameters can be displayed
by selecting the spectral window’s tab. A few input parameters are commented on below.

Clicking the Add button below the summary table, a Spectral Window or a pair of Spectral Windows is added
depending on the receiver type and the choice of Products & Sideband Separation value. Key parameters of
all spectral windows defined in the baseband are displayed in the table. Details about some of these parameters
are described below. The Add From Catalog button starts up the Spectral Line Selection Tool from which a
line can be selected that falls within the selected ALMA frequency band. The use of the Duplicate Selected and
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Figure 8.11: The fields for defining the spectral windows.

Delete are rather obvious.

The value of the centre frequency is constrained to multiples of approximately 32 kHz for the 64-input
correlator and 4 kHz for the ACA correlator. The value typed into the table is adjusted automatically, while you
need to click the Adjust button in the tab. In the spectral window table the colour of the offset turns red if the
spectral window does not fall within the baseband. The field use USB and use LSB cannot be changed for single
sideband (Bands 1 and 2) or two sideband (Bands 3–8) receivers, as the sideband is chosen by the OT according
to the centre and LO1 frequency. For a double sideband receiver (Bands 9 and 10), sideband selection depends
on the choice of Products & Sideband. For the AUTO_ONLY & NONE case, both LSB and USB are selected. This
is due to the restriction that the signal of both sidebands cannot be separated for auto correlation mode. For
the CROSS_AND_AUTO & FREQUENCY_OFFSET_REJECTION case, either use LSB or use USB is selected according
to the centre frequency of the baseband and LO1 frequency, and the selection is not allowed to change. For
the CROSS_AND_AUTO & FREQUENCY_OFFSET_SEPARATION or CROSS_AND_AUTO & PHASE_SWITCHING_SEPARATION
case, two spectral windows are defined at a time as a pair, one in the LSB and the other in the USB. You
can remove the check for either sideband you don’t need. All the spectral window parameters except a few
are common to the spectral windows defined as a pair and the parameters for the both sidebands are displayed
and editable on a tab. Note that FREQUENCY_OFFSET_SEPARATION does not appear in the Product & Sideband
Separation list box for an ACA spectral spec because the ACA correlator does not support this function.

There are restrictions between the nominal bandwidth and the nominal number of channels of the spectral
window for the 64-input correlator. You will see 3 types of representation in the list box for those parameters:
black characters, grey characters, and grey characters with a stroke.

Black characters are used to indicate that the value is valid against the setting of the other. When you see
the list box for nominal bandwidth, choices in black are valid against the current value of number of channels,
and vice versa. Choices in grey with or without stroke are invalid. Stroke means the value is available against
none of the choices of the other. In other words, the value is not available for the settings of other parameters:
polarization, correlation bits, oversampling, and quantization correction. Choices in grey without stroke will be
valid and turn black when one of the valid choices is chosen for the other.

For every Spectral Window at least one Spectral Average Region needs to be set. For the case that spectral
windows are defined as pairs, i.e. sideband separation is selected for a DSB receiver, a check box labelled
Creates the same region in the mirrored window is displayed below the Spectral Average Region table.
As the default this is checked and the regions displayed in the table are applied to the both sidebands. Remove
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the check if you want to set different spectral average regions to LSB and USB, then you will see columns labelled
LSB and USB which allows you to select which sideband or both use the region.

After having created and filled out one or more Instrument Setup forms, clicking on the Resources/Instrument

Setup folder shows a table with the available Instrument Setups.

8.4.4 Observing Parameters

For each target type (science, calibration, optical pointing) the user must specify Observing Parameters. To
create an Observing Parameters set, select the Observing Parameters folder in Resources. Via the Edit menu you
can now select the type of observing parameters you want to add to the Observing Parameters folder. There is
one for adding science parameters, one for the various calibrations as well as for optical pointing, holography
and radiometric pointing. Alternatively, you can right-click and select one of the observing parameters options
from the pop-up menu.

Figure 8.12: The form for the Observing Parameters. The tabs for science and calibration targets and for the
special Observatory Setups are visible. The tabs become visible when the corresponding node in the Observing

Parameters folder in the Project Tree is selected.

When selecting a newly-created node in the Resources/Observing Parameters folder, in the Editors pane will
display the empty observing parameters form. For each of the possible observing parameters sets there is a
separate tab. When selecting a node in Observing Parameters folder the corresponding tab in the Observing
Parameters form is enabled and displayed (see Fig 8.12. The Science Observing Parameters form includes
the name of the parameter set, the representative frequency and bandwidth and the sensitivity goal for that
frequency and bandwidth. For calibration observations, most of the observing parameters include the name of
the parameter set, the cycle time (how often the calibration shall be repeated) and the default integration time.
An exception is the observing parameters for pointing calibrations. This parameter set also contains the desired
accuracy and which pointing method shall be used.

Note that the tabs for science and calibration parameters contain a sub panel Advanced Parameters which is
only intended for Expert use and is described in more detail in Appendix D. After having created one or more
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ObservingParameters data sets, clicking on the Resources/Observing Parameters folder shows a table with the
available observing parameters sets.

8.5 Attaching Resources to Targets

8.5.1 Attaching New or Existing Resources

To attach a resource to the Target, select the Target in the Target folder. Then in the menu bar select Edit

→ Attach/Detach ..., or use the right mouse button. A dialog window will be displayed showing the Field
Sources, Instrument Setups and Observing Parameters that are available in the Resources folder. From the
column Attachable Components the resource can be selected and added to Selected column using the right arrow
button. Detaching resources from a target goes in the opposite direction.

Figure 8.13: A Phase 2 observing program structure that contains one Scheduling Block. The Scheduling Block
contains 5 Targets. Field Source, Instrument Setup and Observing Parameters forms have been created in the
Resources folders. The figure shows the highlighted target HD163296 in the Target folder and the attached
parameter sets.

Attaching resources can also be done at the time a new Target is created. When clicking on the new Target,
the Field Source, Spectral Spec, and the Observing Parameters panels contains a listing of the available resources
that can be selected for the Target. Alternatively, the user can also choose to create and attach a new resource.
In that case a new resource will be created in the corresponding Resources folder and attached to the Target.

After having attached a Field Source, Instrument Setup and one or more Observing Parameters, the Target
information is complete. Clicking on the Target will show the complete Target form in the Editors pane and
highlights the parameters sets in the Resources folder that are attached to the selected Target. Similarly, by
clicking on a resource, the Target to which this resource is attached will be highlighted. An example of this is
visible in Figure 8.13.

When selecting a Target, the form in the Editors pane displays the content of the attached Field Source,
Instrument Setup and Observing Parameters. At the top of each of the Field Source, Instrument Setup and
Observing Parameters forms, a line is displayed that gives the number of targets that use that parameter set.

When it is used by more than one Target, a warning icon and the Edit Only This button appears along
with the information. Editing a parameter set affects all the Targets to which it is attached. To only edit the
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parameter set for the Target which is displayed, click the Edit Only This button. This duplicates the parameter
set and attaches it only to the Target which is being edited.

When selecting a FieldSource, Instrument Setup or Observing Parameters in the Resources folder, the form
in the Editors pane provides information on how many targets are using it.

8.6 Submit the Project

After having completed the Phase 2 observing program, ObsUnitSet, SB and Target forms, the validation
procedure should be run to make sure that the program is technically correct and compliant with the Observatory
policies. Also, the validation can check that the anticipated total observing time does not exceed the Phase 1
allocations and that the data rates are within the limits.

Finally, after successful validation, the Phase 2 program can be submitted to the ALMA Observatory Archive
where it will be checked further and eventually executed.

Detailed information about Project validation and submission can be found in Chapter 3.7.
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Chapter 9

The Visual Spatial Editor

The Visual Spatial Editor allows an image of the source that you wish to image to be loaded and can subsequently
be used to determine where the telescopes should point, either by defining individual pointings or rectangular
mapping areas. The information entered here will also appear in the Forms Editor that always accompanies the
Spatial Editor i.e. it is not necessary to use the Spatial Editor to define any observation with ALMA, although
it will greatly aid in setting up some observations.

The Spatial Editor is enabled by selecting the Spatial tab at the top of the Forms Editor when either of the
following are selected:

• the Field Setup node of a Phase-1 or Phase-2 Science Goal (selecting the Science Goal summary view will
also allow the Spatial Editor to be viewed)

• a Field Source in an SB (selecting a Field Source’s Target will also allow the Spatial Editor to be viewed).

Whilst the Spatial Editor is identical in each case, the Forms Editor is somewhat different and is explained in
detail in Section 6.3.2 (Science Goal) and Section 8.4.1 (Scheduling Block).

Note that use of the Spatial Editor can be enabled by default using the Preferences menu i.e. it will always
be shown when a Field Setup or Field Source is selected.

9.1 Overview of the Graphical Interface

The Spatial Editor’s graphical interface uses libraries provided by the JSky project1 and is dominated by a
window for displaying images (in FITS format). In addition to this, there are also smaller windows for displaying
the entire image (including a yellow square which indicates which portion of the entire image is displayed in the
main window; this can be moved with the mouse) and another that shows the zoomed part of the image that
is centred on the cursor position in the main window. Display of these is optional. The colour bar at the very
bottom of the image can be used to change the image contrast by dragging the mouse within it.

Above the image display there is a toolbar that can be used for various operations including loading and
saving images, manipulating source and target positions and for setting the intensity cut level in the display.
Zooming controls and positional information are located directly below the image window.

An example of the image display can be seen in Figure 9.1.

Below the image display and its menu and control buttons, the FOV Parameters and Image Query panels
are visible (Figure 9.2). The former displays the value of the Representative Frequency (taking into account the
source velocity) and the antenna diameter that shall be used when displaying the antenna beamsize (field of view).
Changing the source in the Forms Editor will change the Representative Frequency to the value appropriate to
that source. The Image Query panel allows the image server and the size of the retrieved image to be specified.

1http://jsky.sourceforge.net/
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A further feature of the graphical interface is the ability to measure the distance between two points within
the image by right-clicking and dragging the mouse (Figure 9.1).

Figure 9.1: An example of the image display area on the Visual Spatial Editor. This shows a pointed mosaic
observation of the outer reaches of NGC 253, the mosaic pointings having been automatically created based on
a user-defined rectangle (green). The x-shaped cross at the centre marks the position of the coordinates given in
the Forms Editor. As this is an observation that requires the ACA, also shown is the rectangular area (in blue)
that will be mapped by the Total Power array. Also shown is the ruler for measuring distances between points
in the image.

9.2 Creating a Field Definition

An image can be loaded in one of two ways, either by loading a local one from disk using the image display’s
toolbar, or by querying an image server, a large number of which are available through a drop-down menu. If
querying a server, the image will be centred on the coordinates entered in the Forms Editor. These are indicated
on the map by a green x-shaped cross which will move if the coordinates are changed.

At present, only FITS file with coordinates defined in the J2000 system are correctly handled. Therefore,
you cannot use the Spatial Editor to set up pointings in Galactic coordinates. The OT will load the image, but
the coordinates will not be displayed correctly.

Once an image has been loaded, if any pointings or a rectangle were previously defined in the Forms Editor,
they will appear on the image and can be edited with the mouse. At the time of loading an image, the type
of field definition must already have been chosen, either a rectangular area or multiple pointings (the latter by
default). It is possible to change the definition using the Spatial Editor by clicking on the opposite definition on
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Figure 9.2: The FOV Parameters and Image Query panels in the Visual Spatial Editor.

the toolbar i.e. by adding a single pointing when a rectangle has already been defined. A warning will be issued
at this stage as the previous definition (size and orientation of rectangle, positions of all pointings) will be lost.
As this implies, it is not possible to create a field definition that contains a mixture of single pointings and a
rectangle.

An important part of the Spatial Editor is the ability to display the antenna beamsizes for each pointing,
either for the 12- or 7-m antennas. For this to be possible though, the Representative Frequency must have
already been defined in the Science Goal’s Spectral Setup. Therefore, it is recommended that this section be
completed before using the Spatial Editor.

9.2.1 Single Pointings

Multiple instances of single pointings can be added to the field definition by using the "Add a FOV" button on
the toolbar and then clicking at the position in the image where the antenna should point – this must be clicked
every time a pointing is to be added. For your convenience, a single pointing is created by default at zero offset
from the source coordinates. Once defined, pointings can be moved using the mouse or deleted. Clicking on a
pointing will cause its background to become opaque - this indicates that this pointing has been selected and
can, for example, be deleted using the scissors icon in the toolbar or moved by being dragged with the mouse.
More than one pointing can be selected at any one time, either by using the rectangular selection button in the
toolbar, or by holding down the CTRL key whilst clicking on each pointing in turn. A subsequent dragging or
delete operation will then apply to all pointings.

The pointings defined in the Spatial Editor are displayed in the Forms Editor where they can be edited or
deleted.

9.2.2 Rectangular Areas

9.2.2.1 Science Goal

Instead of one or more single pointings, it is possible to define a single rectangular area. This is used to
automatically calculate a mosaic of pointings based on the antenna spacing that is entered in the Forms Editor.
This is usually set to some fraction of the antenna beamsize and Nyquist is the appropriate choice in nearly all
cases and also the default. Once a rectangle has been defined, either with the mouse or with the fields in the
Forms Editor, it can be manipulated further by clicking on the coloured boxes - the green box rotates and the
blue boxes resize. Furthermore, the rectangle can be moved by clicking and dragging anywhere in its vicinity.

The mosaic pattern is not currently drawn by default and so the appropriate button in the toolbar must be
selected. The mosaic pattern for either the 12-m or 7-m array can be selected and the number of pointings will
be displayed in the Forms Editor - as the spacing is usually a function of antenna beamsize, the mosaic patterns
will therefore be different for the two arrays. For Phase-I proposals, it is probable that a limit on the number of
pointings has been set for the current ALMA cycle and defining too many will result in a validation error that
will prevent the project being submitted.
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If the ACA has been selected, also displayed will be a turquoise rectangle that is a little larger than the
user-defined rectangle. This indicates the area that will be mapped by the ACA Total Power array and is
non-editable.

9.2.2.2 Scheduling Block

Setting up a rectangular area using the Spatial Editor is essentially exactly the same in the Field Source of a
Scheduling Block, except that it is possible to either convert it into a pointed mosaic or to have the telescopes
scan it in strips.

9.2.3 Offset Versus Absolute Coordinates

When a pointing area is created using the Spatial Editor, its coordinates are interpreted by the OT as an absolute
position (R.A. and Dec.) or as an offset from the source coordinates, depending on what is selected in the Forms
Editor at the time of creation. Because pointing areas are being added with the mouse, which is chosen is not
terribly important and subsequently changing from one to another will convert all positions to the new system.
However, if the source coordinate is changed, the outcome depends crucially on which is currently selected,
namely that offset positions will move within the image whilst absolute positions will not. Be very careful when
changing the source coordinate after setting up a field definition with the Spatial Editor!
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Chapter 10

The Visual Spectral Editor

The Visual Spectral Editor allows the spectral windows that are defined by the user to be viewed in a graphical
environment that contains a number of aids to their placement, particularly the atmospheric transmission and
the receiver/correlator configuration (receiver bands, sidebands, etc.). The spectral window information entered
by the user is also visible as the Forms Editor always accompanies the Spectral Editor i.e. it is not necessary to
use the Spectral Editor to define any observation with ALMA, although it will greatly aid in setting up some
observations. It is strongly recommended that a spectral setup is always checked in the Visual Spectral Editor.

The Spectral Editor is enabled by selecting the Spectral tab at the top of the Forms Editor when either of
the following are selected:

• the Spectral Setup node of a Phase-1 or Phase-2 Science Goal (selecting the Science Goal summary view
will also allow the Spectral Editor to be viewed)

• an Instrument Setup in an SB (selecting a Instrument Setup’s Target will also allow the Spectral Editor to
be viewed).

The Forms Editor for spectral setups is explained in detail in Section 6.3.3 (Science Goal) and Section 8.4.3
(Scheduling Block).

Note that use of the Spectral Editor can be enabled by default using the Preferences menu i.e. it will always
be shown when a Spectral Setup or an Instrument Setup is selected.

10.1 Overview of the Graphical Interface

The Spectral Editor’s graphical interface consists of two frequency axes, one above the other, with the space
in between used to display various features of interest. The two axes themselves show the features in observed
and rest frequencies, depending on the source velocity. The display can be zoomed using mouse clicks (left-click:
zoom in, right-click: zoom out) or the scroll wheel, the zoom being centred at the location of the mouse pointer
(magnifying glass symbol). Once the display has been zoomed, it can be panned by grabbing one of the horizontal
green bars that appear whenever the mouse is somewhere within the graphical area. Additional zooming and
panning controls are located below the graph, as well as a number of other controls.

Just below the observed frequency axis are hatched areas that show the available receiver bands. These are
displayed in grey, apart from the currently-selected receiver band which is coloured blue (and doubly, compared
to singly, hatched). The upper, wider part of the hatched area shows the full range of frequencies that can be
observed using a band whilst a narrower rectangle below this shows the allowed range of the first local oscillator
(LO1).

A prominent feature of the graphical interface is the transmission curve. This shows how much of the radiation
from the source is actually received at the telescope and is calculated using the Atmospheric Transmission at
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Microwaves (ATM) code1 that is also used in the ALMA Sensitivity Calculator and for the OT time estimates.
Years of monitoring have been used to determine the characteristic octiles of precipitable water vapour (PWV)
at the ALMA site and the transmission curve corresponding to each can be selected manually, or the OT can
automatically display the appropriate one. The latter is recommended as it is this value of PWV (or a very
similar one) that will be used to trigger the observation of a project, based upon the spectral windows that
have been defined in the Forms Editor, specifically by the Representative Frequency. Changing the displayed
transmission curve is for experimentation only as it will not affect the conditions assumed for the
observations and hence the OT’s time estimates!

It is also possible to display spectral lines using the Spectral Line Selection Tool which is described in detail
in Section 5.3.

10.2 Viewing a Spectral Setup

The main purpose of the Spectral Editor is to allow the spectral setup to be viewed against the background of
the transmission curve and available spectral lines. The spectral windows themselves must be defined using the
Forms Editor as it is not possible do this using the graphical interface. These in turn are used by the OT to
calculate a tuning solution that sets the positions of the basebands and sidebands. Together with the spectral
windows, these can be viewed in the Spectral Editor, the exact details of what can be displayed depending on
whether a Science Goal or a Scheduling Block is being viewed.

10.2.1 Science Goal

After defining spectral windows in the Forms Editor, these will appear in the Spectral Editor as vertical blue
lines marking the central frequency and a horizontal bar to indicate the bandwidth. If no warnings have been
issued by the OT, a tuning solution will have been found and the sidebands and LO1 indicator will be coloured
yellow. For a tuning solution to have been found, it should be the case that all of the spectral windows fit within
the sidebands. However, it is possible that small portions of the spectral windows do lie outside the sidebands,
but as long as these are coloured yellow, there is nothing to worry about.

An example of the Science Goal graphical display can be seen in Figure 10.1.

Figure 10.1: The graphical representation of the frequency information in a Science Goal. Four spectral windows
are shown, a narrow one to observe the CO(3-2) transition and three other maximum-bandwidth ones for mea-
suring a continuum. All four fit within the sidebands which are coloured yellow (as opposed to grey) to signify
that a valid tuning solution has been found. The displayed transmission curve has been set to a value (3rd octile)
appropriate for the frequency being observed. Also visible are the various controls as well as the green bars that
must be grabbed to pan the display.

1e.g. Pardo, J. R., Cernicharo, J., Serabyn, E., 2001, ITAP, 49, 1683.
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For experimentation purposes, it is possible to move the sidebands by dragging the LO1 marker, but as soon
as the mouse is released, the sidebands will return to their original position. This is because the ALMA tuning
solution is calculated by an algorithm that takes the spectral window frequencies and bandwidths as input i.e.
the value of LO1 is not settable by the user.

The Targets panel in the Forms Editor contains a table with an overview of relevant source properties,
including their velocity and Representative Frequency. If multiple sources have been defined, this table allows
the user to display the spectral windows according to this source’s velocity. Only one source at a time can be
selected. The sidebands do not presently react to this change of velocity - they always show the tuning solution
for the first source in the table.

As part of the tuning solution, the OT will also have calculated the positions of the basebands, but these are
not currently displayed in the Science Goal Spectral Editor.

10.2.2 Scheduling Block

The graphical display in an SB is similar to that of the Science Goal, but shows more features of the spectral
setup that is displayed/defined in the Forms Editor and allows more control over what is displayed.

The key features that are visible in an SB, but not in a Science Goal are the basebands and the spectral
averaging regions. As this is a lot of information to display, what is shown depends on the level of zoom that is
being used. At low levels of zoom, only the sidebands and the basebands are visible. Further zooming in will
also show the spectral windows contained within each baseband, as well as the spectral averaging regions of each
spectral window.

An example of the Scheduling Block graphical display can be seen in Figure 10.2.

Figure 10.2: The graphical representation of the frequency information in a Scheduling Block. This is a zoomed
view and hence the spectral windows and their spectral averaging regions can be seen. The basebands are shown
as the green blocks and within these can be seen the spectral windows (horizontal bars). Below the basebands
are the spectral averaging regions (also horizontal bars). Note that there are two spectral windows in Baseband
2, each with a single spectral averaging region. Baseband 3 contains a spectral averaging region which extends
out of the spectral window and has thus been coloured orange to signify a problem.

Unlike in a Science Goal, it is possible to move the sidebands and LO1 using the mouse and this will
even update the value of LO1 displayed in the Forms Editor. However, this will again be ignored when the
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observations are performed as the ALMA Control system will derive its own tuning solution using the spectral
window frequencies passed to it by the OT.

Whilst most of the controls are self-explanatory, the following are worth mentioning briefly. Checking Fold
Basebands and Fold Spectral Windows allows the tool to use less vertical space, whilst Track selection
results in which ever baseband is selected in the Forms Editor to be shown zoomed.

Source velocities are slightly tricky in the context of the Spectral Editor in a Scheduling Block. If the Spatial
Editor is being viewed inside a Target, then things are simple and the velocity of that source will be used.
However, if viewing the graphical display from within an Instrument Setup, this can potentially be attached to
multiple Targets and therefore different sources. For calibrator Targets, these will use the velocity of the source
contained in the Representative Target. For science Targets, the first source in the Field Sources folder which is
attached to a Target will be used. However, regardless of which velocity is used, its value and the source it is
taken from is displayed in the Forms Editor, just below the Calculate LOs button.
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Appendix A

Project Conversion Tool - Command Line

Version

A command line tool for converting a project from an old version to the current version has been added to the
user distribution. This tool is currently only available to unix users and (we think) MacOS users: a version for
windows will follow. However, the recommended approach is to use the version that is incorporated into the
"import from disk" feature (see above). Eventually this will also be incorporated into retrieving from the ALMA
Archive too.

To use the present command line version of the tool:

• You must be on a unix platform (MacOS might work).

• You must retrieve the tarball or zip version of the OT or the much smaller tarball or zip file called the
"AlmaConverter" (this smaller download only contains the conversion tool and therefore allows Web Start
users to convert their projects with minimum download requirements).

• You should follow the usual instructions for downloading and unpacking – in particular it is very important
to run the PostInstall-CommandLine.sh script

• You then convert projects using the command:

– ALMA-Convert-Project.sh <inputproject.aot> <outputproject.aot>

– NOTE: It is necessary to be connected to the internet when running this tool as parts of it rely on
web access.

• This will convert any project created since, and including, User Test 4.0 so that it is able to be imported
into the current version of the OT.

• We recommend importing and running validation after the conversion.

• Running ALMA-Convert-Project.sh -h will provide some help.
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Appendix B

Create an External Ephemeris

This Appendix explains how to use the HORIZONS system provided by JPL to create a text file format ephemeris
file which can be used as an external ephemeris file in OT.

B.1 NASA resources for HORIZONS

• http://ssd.jpl.nasa.gov/horizons.cgi: Direct link to the HORIZONS web interface (which is
what is covered here)

• http://ssd.jpl.nasa.gov/?horizons: HORIZONS web page (web interface link can be found here,
in addition to multiple formats for documentation)

• ftp://ssd.jpl.nasa.gov/pub/ssd/Horizons_doc.pdf: PDF user manual. Provided as a reference
(very detailed, not required for following the steps outlined here)

B.2 Instructions and Setting

Below follow the instructions bullet list for making an output file from HORIZONS compatible with ALMA
software.

• Go to http://ssd.jpl.nasa.gov/horizons.cgi

• Ephemeris Type should be "Observer"

– This should be the default. If not, click the "change" link immediately to the right
of "Ephemeris Type", and select "Observer Table"

– Click "Use Selection Above" button

• Set your "Target Body"

– Click the "change" link immediately to the right to put in what you want

• "Observer Location" should be "Geocentric" (probably the default)

• "Time Span" should be set as needed (clicking "change" link immediately to the right to get
fields for a time range)

• "Table Settings":

– Click "change" link immediately to the right of "Table Settings"
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– This will bring up a lot of check boxes

– There are 2 checkboxes that must be checked:

∗ "Astrometric RA & DEC"
∗ "Obsrv range & rng rate"

– All other settings are optional

• Important: for "Display/Output"

– Click "change" link next to "Display/Output"

– Select "plain text"

– Click "Use Selection Above"

• Once done, double check your Current Settings, to make sure they match all the settings above.

• If OK, click the "Generate Ephemeris" button

• The page can then be saved as a file through the browser

– Remember to include the ".txt" extension on the filename
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Appendix C

Observatory Setups

In a Phase 2 program, apart for the defining Science Goals, Observatory Staff can also specify Observatory
Setups as part of the Science Plan. Currently, there are setups for holography and astro-holography, optical and
radiometric (also known as interferometric) pointing, baseline calibration and for calibration survey. The goals
can be added by right-clicking on the Science Plan node in the project tree and selecting one of the options in
the Add Observatory Setup from the context menu as appropriate. These options can also be found in the Edit
menu, under Add Observatory Setup.

C.1 Holography

C.1.1 Astro-Holography

To support setting up an Astronomical Holography SB a "helper" dialogue is provided. With the Science Plan

node highlighted either right click and select Add Astro-Holography Setup or from the Edit menu choose
Add Observatory Setup/Add Astro-Holography Setup. This will produce a dialogue asking for a source
name, an observing frequency and the name(s) of the reference antennas that is/are to be used:

• Source name: this will be resolved in the same way as would normally happen from the Field Source editor

• Observing Frequency (defaults to 104 GHz): This will be used to setup a spectral spec.

• Reference antennas: Provide a comma separated list of antennas, to be used in the ”Expert Parameters"
of the SB to direct which antenna(s) this SB should be executed on.

When clicking on OK an Astro-holography SB will be created. Naturally the SB may be edited afterwards in
the usual manner. In particular if one wish to enter a source that cannot be resolved by the usual name resolvers
then leave this field blank. The rest of the SB will be created and may be edited in the Field Source form then.
Similarly the reference antennas field may be left blank and filled (or changed) later.

This setup only allows for one target. More may be added to the SB later if desired.

C.2 Optical Pointing

Still to be added
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C.3 Radiometric Pointing, Baseline Calibration, and Calibrator Sur-
vey

These three goals have a common structure. Each contains:

• A target list

• A calibrator list

• A spectral setup

Each source in the target list and calibrator list will be observed using the one spectral setup specified here.
The target list and calibrator list are edited using the target list and calibrator editors, described below, while
the spectral setup is edited using the same spectral setup editor as used throughout the OT. When the target
list, calibrator list and spectral setup are to your satisfaction, SBs can automatically generated from the goal
by right-clicking on the goal in the project tree and selecting Generate SBs from the selected goal, just as when
generating SBs from a Science Goal. The current SB generation strategy is to:

• Generate two observing groups: Observing Group 1, for initial calibrators, and Observing Group 2, for
goal targets and repeated calibrations.

• Create a virtual target for each calibrator in the calibrator list, apart from the phase calibrator. Each of
these calibration Targets is added to Observing Group 1, and will be observed in an initial calibration pass
when the project is executed.

• If a phase calibrator is specified, create a phase calibrator virtual Target and add it to Observing Group 2.
This phase calibration target will be observed at regular intervals throughout the project. The specifics of
how frequently it will be observed can be changed by editing the PhaseCalParameters, which can be found
as a leaf node of the generated SB in the project tree.

• A target will be created in Observing Group 2 for each calibrator in the predefined target list, or alterna-
tively one virtual target containing the user’s search criteria will be created if the list is to be generated at
project execution time.

Below the Target List and Survey Calibrators form are discussed. The form for the Spectral Setup is identical
to the form for a Science Goal (see Section 6.3.3.

C.3.1 Target List Editor

To edit the Target List expand the goal in the project tree and click on Target List. The Target List form is
displayed in Figure C.1.

The target list is compiled from the ALMA calibrator catalogue. These targets can either be explicitly set
beforehand, or the target list can be compiled by searching the ALMA calibrator catalogue at project execution
time.

To use a dynamically-generated target list, select the Generate target list at execution time option.
To edit the search criteria used to generate the target list, click the Edit Selection Criteria button to launch
the Target List Query Editor. This will start the Target List Query Editor where the search parameters can be
specified. The form is very similar to the Calibration Selection Tool described in Section 5.4 with the exception
of the maximum number of targets that can be specified here. An example form is visible in Figure C.2. A
search of the ALMA calibrator catalogue will be performed at project execution time and the resulting matches
used as the survey target list.

Alternatively, to fix the targets beforehand, select the User-selected target list option. This will startup
the Target List Selector which is identical to the Calibration Selection Tool. After the selection the various
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Figure C.1: An example of the Observatory Goal Survey Target form.

buttons at the bottom can be used to manipulate the ]User-selected target list. e.g Add... and Remove to add
and remove calibrators.

The integration time spent on each target in the target list can be set by entering a value in the Integration
time per target entry box.

C.3.2 Calibration Editor

Expand the goal in the project tree and click on Survey Calibrators to edit the calibrators observed as part
of your project. The calibrators editor is shown in Figure C.3.

Note that calibrators are always found by searching the ALMA calibrator catalogue at project execution
time!

There are two options here: either select the System selects calibration strategy option and let the
OT decide on which calibrators should be observed and the search criteria used to find them by, or explicitly set
the calibrators yourself.

If you wish to set the calibrators yourself, select the User-defined calibration option and use the Add
Calibration... button to add calibrators to your goal. Eight different kinds of calibrator target can be
added: amplitude, atmospheric, bandpass, delay, focus, phase, pointing and polarization. The search criteria
used to identify each type of calibrator can be edited by clicking the appropriate Edit Calibrator Selection
Criteria... button in the table, next to the calibrator type. This start the Calibration Query Editor in which
the calibrators can be selected. Calibrators can be removed from the list by clicking the Delete Selected
Calibration button.
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Figure C.2: An example of the Target List Query form. The maximum number of targets is unlimited.

Figure C.3: An example of the Survey Calibrators form.
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Appendix D

Expert Parameters

Expert Parameters will not be exposed to the normal user by the time of the first Call for Proposals. Documen-
tation about these will normally be placed in this Appendix.

D.1 Advanced Parameters in Observing Parameters and Scheduling
Blocks

In the Observing Parameters panel of a project, an additional panel Advanced Parameters enables the devel-
opment of observing modes and can be used for Keyword-Value pairs specification. They are not intended for
operational usage but rather to decouple script development from the release cycle of the Alma Project Data
Model (APDM) and the Observing Tool.

Similarly, the same concept has been added to Scheduling Blocks. This is also for expert use only and is
intended to allow ALMA commissioning scientists to experiment to see what is needed in the way of passing
parameters to the standard observing mode scripts. The expectation is that as certain keywords are found
necessary then they will be considered for permanent addition to the APDM.

Figure D.1: The Advanced Parameters panel in Observing Parameters and Scheduling Blocks forms for specifying
expert parameters via Keyword-Value pairs.

The editor for expert parameters is the same in both places: A panel called Advanced Parameters is available
in the SB or Observing Parameters, collapsed by default. Opening it reveals a table editor that allows the addition
and deletion of free-form Keyword-Value pairs. These are simply strings passed to the SB and interpreted by
the script in any way the script writer desires.
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Appendix E

Acronym List

2SB: Two sideband (ALMA bands 3–8)
ACA: Atacama Compact Array
ALMA: Atacama Large Millimeter/submillimeter Array
APC: Atmospheric Phase Correction
APDM: ALMA Project Data Model
ARC: ALMA Regional Centre
ASC: ALMA Sensitivity Calculator
ATF: Alma Test Facility
BBC: BaseBand Configuration
BL: Baseline (e.g. BL Correlator)
DBB: Database Browser
DFS Data Flow System
DSB: Double Sideband (ALMA bands 9 and 10)
FOV: Field Of View
FFT: Fast Fourier Transform
HLA: High Level Analysis
GUI: Graphical User Interface
ID: Identifier
IPT: Integrated Product Team
JDK: Java Development Kit
JRE: Java Runtime Environment
JVM: Java Virtual Machine
LO: Local Oscillator
LSB: Lower Side Band
ObsUnitSet: Observation Units Set
OT: Observing Tool
OTF: On The Fly (mapping)
PI: Principal Investigator
SB: Scheduling Block
SSB: Single Sideband (ALMA bands 1 and 2)
SSR: Science Software Requirements
SFI: Single Field Interferometry
TAC: Time Allocation Committee
TFB: Tunable Filter Bank
VLA: Very Large Array
USB: Upper Side Band
UT: User Test
XML: Extensible Markup Language
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